
Macintosh® Utilities 
User's Guide 

• File Edit Uiew Special 

Utilities 2 
5 items 713K in dtsk 

:",· 
··~ ~D Utilities 1 

6 items 773K in disk 

00 CJ 
System Folder Special Installer Scripts 

il€J ~ C:J 
Apple HD SC Setup Disk First Aid 

~ 
Installer 

~~ 
I;:::) 

HDBackup 



LIMITED WARRANTY ON MEDIA AND REPLACEMENT 

If you discover physical defects in the manuals distributed with an Apple product or in the 
media on which a software product is distributed, Apple will replace the media or manuals 
at no charge to you, provided you return the item to be replaced with proof of purchase 10 

Apple or an authorized Apple dealer during the 90-day period after you purchased the 
software. In addition, Apple will replace damaged software media and manuals for as long 
as the software product is included in Apple's Media Exchange Program. While not an 
upgrade or update method, this program offers additional protection for up to two years or 
more from the date of your original purchase. See your authorized Apple dealer for 
program coverage and details. In some countries the replacement period may be different; 
check with your authorized Apple dealer. 

All IMPLIED WARRANTIES 0 11IF. MEDIA AND MANUAIS, INCLUDING IMPLIED 
WARRANTIES OF MERCHANTABlllTY AND FITNESS FOR A PARTICULAR PURPOSE, 
ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF THE 
ORIGINAL RETAIL PURCHASE OF nus PRODUCT. 

Even though Apple has tested the software and reviewed the documentation, APPLE MAKES 
NO WARRANTY OR REPRESENTATION, EITHER EXPRESS OR IMPLIED, WITH 
RESPECT TO SOFTWARE, ITS QUAllTY, PERFORMANCE, MERCHANTABlllTY, OR 
FITNESS FOR A PARTICULAR PURPOSE. AS A RESULT, nus SOFTWARE JS SOID "AS 
ISt AND YOU THE PURCHASER ARE ASSUMING THE ENTIRE RISK AS TO ITS 
QUAllTY AND PERFORMANCE. 

IN NO EVENT Will APPLE BE UABLE FOR DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY DEFECT IN 
TIIE SOFTWARE OR ITS DOCUMENTATION, even if advised of the possibility of such 
damages. In particular, Apple shall have no liability for any programs or data stored in or 
used with Apple products, including the costs of recovering such programs or data. 

THE WARRANTY AND REMEDIES SET FORm ABOVE ARE EXCLUSIVE AND IN LIEU 
OF All OTHERS, ORAL OR WRilTEN, EXPRESS OR IMPLIED. No Apple dealer, agent, 
or employee is authorized to make any modification, extension, or addition to this warranty. 

Some states do not allow the exclusion or limitation of implied warranties or liability for 
incidental or consequential damages, so the above limitation or exclusion may not apply to 
you. This warranty gives you specific legal rights, and you may also have other rights which 
vary from state to state. 

WARNING 

This equipment has been certified to comply with the limits for a Class B computing device 
pursuant to Subpart J of Part 15 of FCC rules. Only peripheral devices (computer input/output 
devices, terminals, printers, and so on) certified to comply with Class B limits may be 
attached to this computer. 

Operation with noncertified peripheral devices is likely to result in interference to radio and 
television reception. 
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This manual and the software described in it are copyrighted, with all rights reserved. 
Under the copyright laws, this manual or the software may not be copied, in whole ~ 

or part, without written consent of Apple, except in the normal use of the software or 
to make a backup copy of the software. The same proprietary and copyright notices 
must be affLXed to any permitted copies as were affLXed to the original. This exception 
does not allow copies to be made for others, whether or not sold, but all of the 
material purchased (with all backup copies) may be sold, given, or loaned to another 
person. Under the law, copying includes translating into another language or format. 

You may use the software on any computer owned by you, but extra copies 
cannot be made for this purpose. 
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About the Macintosh Utilities 

- HE MAC/tvTOSH l.Jl7U17ES USER'S GUIDE DESCRIBES TEN UTILl1Y PROGRAMS 

designed for use with your Macintosh® computer. They are found on the 

two Utilities disks. 

This manual assumes that you have already mastered the basics of your 

Macintosh, as explained in your Macintosh System Software User's Guide. If 

you need a quick refresher on the use of the directory dialog box, refer to the 

Appendix, "Moving Through the File System," in this guide. 
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What's in each chapter 

Read the chapter descriptions below to decide which utilities you're likely to 
find useful. 

• Chapter 1 describes Apple HD SC Setup, which is found on Macintosh 
Utilities disk 1, and tells you how to create a startup bard disk. 

You need Apple HD SC Setup to prepare and test any of the Hard Disk SC 
series of Apple hard disks. This version of Setup allows you to partition 
your hard disk for use with more than one operating system-that is, 
your Macintosh hierarchical file system and another operating system, 
such as A/UX®, Apple's version of the AT&T UNIX® system for the 
Macintosh. However, if you don't need to partition your disk, just skip 
that section of Chapter 1. 

Apple HD SC Setup is also found on the System Tools disk, and a version 
of Apple HD SC Setup is included on the disk and in the owner's guide 
that accompany the external Apple Hard Disk SC's. If you're upgrading 
your Macintosh with an internal hard disk, you probably need to use the 
version of Apple HD SC Setup that's on Utilities disk I to prepare the disk 
for use. In that case, you need to read this chapter. 

• Chapter 2 explains HD Backup, an application that helps you protect your 
hard disk files by copying them onto 3.5-inch disks and restoring them, if 
necessary. HD Backup is found on Utilities disk 1. 

• Chapter 3 describes Disk First AidTM, which is also found on Utilities disk 1. 
You use Disk First Aid to examine and repair damaged disks. Please note: 
Disk First Aid works best if you set up a "Disk First Aid disk," as 
described in Chapter 3, before you need to use the program. 

• Chapter 4 covers Font/DA Mover, which you need to transfer fonts and 
desk accessories to and from a System fi le. Font/DA Mover is found in 
the Font/ DA Mover Folder on Macintosh Utilities disk 2. 

• Chapter 5 describes Find File, a desk accessory that helps you search for 
and open files. The current version of Find File contains a "Move to 
Desktop" command. If you're already using Find File without this 
feature, you'll probably want to replace it with the current version. Find 
File is found in the Desk Accessories file in the Font/DA Mover Folder on 
Utilities disk 2. 

xii Preface: About the Macintosh Utilities 
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• Chapter 6 explains MacroMaker, a utiliry that allows you to record 
sequences of characters and commands and play them back by using the 
MacroMaker menu or by pressing keys or key combinations that you've 
assigned. The MacroMaker Folder on Utilities disk 2 contains MacroMaker, 
the MacroMaker Help file, and a preset Macros file for use only with the 
Apple Extended Keyboard. 

• Chapters 7 and 8 describe Apple File Exchange (AFE), which you can use 
to transfer and translate files between the Macintosh and certain 
other computers. AFE appears, along with the translator file DCA-
RFT /MacWrite, which is also explained in Chapters 7 and 8, in the Apple 
File Exchange Folder on Utilities disk 2. Chapter 7 introduces you to Apple 
File Exchange and explains how to use it. Chapter 8 tells you how to take 
advantage of the file exchange utility's advanced features. 

• Chapter 9 tells how to use Map, a utility that you install in the Control 
Panel desk accessory. Map allows you to display the location and time 
zone of cities and other locations anywhere on Earth, and to compare the 
time and calculate the distance between any selected location and your 
current location. Map is found on Utilities disk 2. 

• Chapter 10 tells you how to use the Installer, found on Utilities disk 1, to 
carry out a special installation. You can create a startup disk containing a 
small System Folder, tailored to your particular kind of Macintosh, and 
you can set up your Macintosh as a workstation using the AppleSharefM 
file server. 

• Chapter 11 explains Close View, a utiliry which, when it is installed in your 
Control Panel desk accessory, allows you to magnify the contents of your 
Macintosh screen. Because Close View is designed primarily for use by 
visually impaired people, Chapter 11 is printed in larger type than the rest 
of this manual, and it contains its own, large-print version of the 
chapter's table of contents. Close View is found on Utilities disk 2. 

• The Appendix, mentioned earlier, summarizes how to use the Macintosh 
directory dialog boxes, something you need to know, nor only to use 
these utilities, bur to work with most Macintosh applications. 

Utiiities disk 1 contains those ucilities which are most useful on a starcup 
disk: Apple HD SC Setup, Disk Firsc Aid, and at times HD Backup and che 
Installer muse be opened from a 3.5-inch scartup disk (unless you have more 
than one hard disk). 

What's in each chapter xiii 



However, the System Folder on Utilities disk 1 contains none of the printer 
resources found on your Printing Tools disk, and it does not contain all the 
system software found on your Macintosh System Tools disk. Its System file 
does not contain all the fonts and desk accessories found on your Macintosh 
System Tools disk, but those missing fonts and desk accessories are also 
found in the Fonts file and Desk Accessories file in the Font/DA Mover 
Folder on Utilities disk 2. (For more on System files, System Folders, and 
startup disks, see your Macintosh System Software User's Guide. See 
"Font/ DA Mover," Chapter 4 in this guide, to learn how to install fonts and 
desk accessories.) 

If the utilities and folders described here are nor in view on your Macintosh 
desktop, select and open (or double-click) the icon representing either utilities 
disk. 

Special text elements 

Several special elements in this manual's text are designed to make learning 
easier. 

•!• Note: A note like this presents additional information or interesting 
sidelights. 

6 Important Be sure to read every item that's labeled this way, with a tag in the 
margin. ~· 

.A. Warning Warnings like this alert you to situations where you could damage software 
or lose data . .A 

Definitions of terms and references to 
ocher parts of the book sometimes 
appear in the margin. 

Terms in boldface type are defined in the glossary. Sometimes the 
definition or additional information about such terms also appears in the 
margin. 
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Apple HD SC Setup 

1 
OU NEED APPLE HD SC SETUP, A PROGRAM FOUND ON YOUR MACINTOSH 

Utilities disk 1, to prepare for use any Apple® SCSI Hard Disk- such as the 

Apple Hard Disk 20SC, the Apple Hard Disk 40SC, or the Apple Hard Disk 

80SC-that's connected internally or externally to a Macintosh® computer 

with a SCSI port. 

SCSI (commonly pronounced "SKUH-zee") stands for Small Computer 

System Interface. Any peripheral device, such as an Apple Hard Disk SC, that 

is designed to operate connected to the SCSI port found on the Macintosh 

Plus, the Macintosh SE, and the Macintosh II is called a SCSI device. 



-You can also use HD SC Setup to test your Hard Disk SC hardware and to 
divide your disk into partitions. This is an advanced feature of HD SC Setup ,_ 
that you use only if you plan to use your Hard Disk SC to store information 
from other types of computers or operating systems. (The last section of 
this chapter, "Creating Partitions," discusses this feature.) 

6. Important To avoid problems, close all other applications before using Apple HD SC 
Setup, and make sure MultiFinder is turned off. 6 

2 Chapter I: Apple HD SC Setup 

For most purposes, you need to use a copy of Apple HD SC Setup, Version 
2.0, that is on a 3.5-inch startup disk, such as your Utilities disk 1. 

Earlier versions of HD SC Setup 

If you 're cwrently using a hard disk that was prepared using a version of 
Apple HD SC Setup before 2.0, keep both that version and the current version. 
In some situations, you may need to use the earlier one. (See "Replacing a 
Damaged Driver," later in this chapter.) 

However, if you're preparing a new hard disk, in addition to having a hard 
disk that was prepared using an earlier version of Apple HD SC Setup, it 
probably makes sense to prepare both disks with the current version of 
Setup, to avoid confusion. In that case, you may be able to prepare the new 
hard disk, back up your files from the old one onto the new one, and then 
prepare the old one. 

You can determine the version number of any copy of Apple HD SC Setup by -
selecting its icon and choosing Get Info, or you can look at the top line of 
the dialog box tl1at appears when you open Setup (shown later in Figure 1-1). ,.... 
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6. Important 

Hard disk ID 

SCSI cables lee you connect up co seven SCSI devices on one system with a 
Macintosh. Each device must have a unique SCSI ID number, which serves 
as a kind of address. Just as you cannot receive mail without an address, 
neither the computer nor a device can send or receive files without a correct 
SCSI ID number. 

Under no circumstances can two devices have the same SCSI ID number. 
You muse assign a different ID number to each SCSI device that connects to 
a SCSI cable. tJ. 

Eight SCSI ID numbers are available to SCSI device users: 0 through 7. The 
Macintosh is always assigned number 7, which has highest priority. The SCSI 
number of an Apple internal hard disk is always 0. You can assign 1 through 6 
to devices that connect to your Macintosh . 

See the Hard Disk SC Owner's Guide for information on sening the SCSI ID 
number on an external hard disk. You must set the ID number and connect 
your hard disk to the Macintosh before you can initialize it. 

Hard disk ID 3 



Initializing your Hard Disk SC 

The first time you start up your Hard Disk SC you need to run HD SC Setup 
to initialize the disk-that is, to prepare it to receive information by 
organizing its surface into tracks and sectors. 

1. Start your Macintosh using your Utilities disk 1 as the startup disk. 

2. Open Setup by selecting its icon and choosing Open from the File 
menu, or by double-clicking the icon. 

A dialog box appears. (See Figure 1-1.) 

OpJ11l• 110 ~l SPIUJ ll > f 
Version number - - - - - --- - - ----- ----/ 
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Figure 1-1 
The main Apple HD SC Setup dialog box 

Next to the words "SCSI Device" is a number from 0 to 6. If you have 
only one Hard Disk SC, the preset ID number of the drive automatically 
appears as the SCSI device number. 

6. Important If you have two or more Hard Disk SC's connected, make sure that the SCSI 
device number matches the SCSI ID indicator number of the hard disk you 
wish to prepare or test. If they do not match, click Drive until they do. The 
SCSI ID number of your Apple internal hard disk is always 0, but if you have a 
SCSI hard disk from another manufacturer, consult your hard disk owner's 
manual. !:::. 

4 Chapter 1: Apple HD SC Setup 
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If, when you click Drive, the number of the second drive does not appear, 
the disk may be switched off or incorrectly connected. Check your power 
switch and connections. 

The Update, Partition, and Test buttons are explained lacer in this chapter. 

._ Warning Make sure that you have chosen the hard disk that you want to initialize, and 
not some other hard disk. Initializing destroys all information on the hard 
disk. "" 

A driver is a program that lets a 
peripheral device and computer send 
and receive ftles. 

3. Click Initialize. 

A dialog box appears, reminding you that initializing erases all of the 
information from the hard disk. To continue, click !nit. 

Messages appear in the Setup dialog box, explaining the course of the 
initialization. Initialization takes several minutes. The exact length of time 
depends upon the size of your hard disk and type of Macintosh. 

In addition to preparing the disk, Setup's Initialize command 
automatically tests the disk and installs the driver, which controls 
exchanges between the hard disk and your Macintosh. 

If you see a message that the hard disk failed to initialize properly, cry 
again. If you are still unable co initialize, there may be a hardware problem. 
See your authorized Apple dealer. 

4. If necessary, name the disk. 

Unless the disk is already named, a message cells you when initializing has 
been successfully completed and asks you to name the disk. You can type 
up to 27 characters, and you can use any keyboard character except the 
colon(:). 

Press the Return key when you are sure you have entered the right name. 

5. Click Quit. 

If you plan to partition your disk, click Partition instead of Quit. Then 
tum to the section "Creating Partitions" later in this chapter. 

Clicking Quit returns you to the desktop, where the Hard Disk SC icon 
appears with the name you gave it. 

Initializing your Hard Disk SC 5 



Setting up the 
System Folder 

Creating a startup hard disk 

To take full advantage of the speed and storage capabilities of your Hard 
Disk SC, you probably want to make it a startup disk. A startup disk is any 
disk that has the necessary program files-such as the Finder and System file, 
which are contained in the System Folder-to set the computer into 
operation. (See your Macintosh System Software User's Guide for a full 
discussion of startup disks.) 

You need only one startup hard disk, regardless of how many SCSI hard disks 
are attached to your system. 

There is no System Folder on the hard disk that you've just initialized. To 
put a System Folder on your hard disk, follow these steps: 

1. Insert your System Tools disk into your internal 3.5-inch disk drive. 

If you want to use a System Folder that you have already customized, 
then insert instead the disk that contains that System Folder. 

6. Important Do not use the System Folder from your Utilities disk 1. It may not contain 
all the fonts, desk accessories, and printing software found in the System 
Folder on your Macintosh System Tools disk. 6 

6 Chapter 1: Apple HD SC Setup 

2. Switch on your Macintosh. 

3. Copy the System Folder from the current startup disk to the hard 
disk by dragging the System Folder icon to the hard disk icon. 

4. If you're using a customized version of the System Folder that 
contains old system files or resources, use the Installer to update 
them. 

The Installer is found on the System Tools disk and is described in your 
Macintosh System Software User's Guide. 
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5. If necessary, use Font/DA Mover to add or remove fonts and desk 
accessories from your System me. 

Font/DA Mover is in the Font/ DA Mover Folder on your Utilities disk 2. It 
is described in this guide. 

6. Choose Restart from the Special menu to restart your Macintosh 
with your hard disk as the current startup disk. 

When you switch on the Macintosh, ic automatically looks for a startup disk 
in this order: 

1. Internal 3.5-inch disk drive(s). If you have a Macintosh SE with two disk 
drives, it looks first at the lower drive. If you have a Macintosh II with 
two disk drives, it looks first at the drive on the right. 

2. External disk drive. 

3. A Macintosh Hard Disk 20 (not a SCSI device). 

4. The SCSI hard disk with the highest ID number. 

5. Another SCSI hard disk with the next-highesc ID number. 

If you wish to start up from your hard disk, do not insert a 3.5-inch disk 
until your Macintosh is operating. If you insert a 3.5-inch disk containing a 
System Folder when (or before) you switch on your computer, it becomes 
the current startup disk. 

If you insert a 3.5-inch disk that is not a startup disk, your Macintosh ejects 
it and continues to scan for a startup disk. 6. 

Creating a scarru p hard disk 7 



Redesignating the 
startup device 
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If you have a Macintosh SE or Macintosh II, you can use the Control Panel to 
override the scanning sequence during startup. 

1. Choose Control Panel from the Apple menu. 

2. Click the Startup Device icon. 

Use the scroll bar if necessary to bring the Startup Device icon into view. 

3, Click the icon that represents the hard disk you want to use to 
start up. 

When you start up your computer, the system uses that hard disk as the 
startup disk, unless there is a 3.5-inch disk inserted or a non-SCSI hard disk 
connected. 

If you no longer want to designate the hard disk as your startup device, 
hold down the Command key and click the hard disk's icon in the Control 
Panel to deselect it. 

4. Close the Control Panel 

•:• Note: If you have set your internal hard disk (SCSI device 0) as the startup 
device, and you want your Macintosh to ignore that hard disk during 
startup, press a combination of four keys-Command, Option, Shift, and 
Delete. The internal hard disk cannot be switched off separately. 

-

-

..... 

-



--
... 

-

-
--

-

Updating the driver 

Whenever Apple develops a new version of the hard disk driver, it is built into 
Apple HD SC Setup. Setup's Update function is designed to allow you to 
install the latest version of the driver without erasing the information on 
your disk. Initializing, on the other hand, erases everything on your disk. 

You may be able to update the driver if you have a version of Apple HD SC 
Setup later than version 2.0. You cannot, however, use version 2.0 or later 
versions of Apple HD SC Setup to update a hard disk that is initialized 
with a version before 2.0. If you need to replace a version before 2.0 with 
a newer version, you must back up your files, initialize the disk with the 
newer version, and then restore your files to the disk . 

To update your driver: 

1. Start up your Macintosh using your Utilities disk 1 as the startup 
disk. 

2. Open Apple HD SC Setup by double-clicking its icon. 

Make sure the SCSI device number matches the SCSI ID number of the 
disk drive that you want to update. If it does not, click Drive until the 
device number and the SCSI ID number match. 

3. Click Update. 

4. When Setup notifies you that the update is complete, click Quit to 
exit from Setup. 

Updating the driver 9 



Replacing a damaged driver 

You can also use Apple HD SC Setup's Update command to replace a 
damaged driver without erasing your disk. If your disk is initialized with a 
version of Setup earlier than 2.0, use that version to replace the driver. Later 
versions won't work. 

After you have properly connected and initialized your hard disk, if the Hard 
Disk SC icon doesn't appear on the Macintosh Finder desktop when you start 
up your machine, follow these steps: 

1. Check that the hard disk is switched on. 

If you have two or more Hard Disk SC's connected to your Macintosh, be 
sure to switch both on and leave them on for at least 10 seconds before 
you switch on your Macintosh. 

2. If you can't start up using the hard disk as a startup disk, replace 
its System Folder. 

Restart the computer from another disk. Copy an undamaged version of 
the System Folder onto the problem hard disk . 

.A Warning When you replace a System Folder, all of the files it contains are erased, so be 
sure to replace it with a copy containing the same fonts, desk accessories, 
and software for peripheral devices. For this reason, you should keep a copy 
of your System Folder on a backup disk. .&. 
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3. If the Hard Disk SC icon still doesn't appear on the Macintosh 
Finder desktop, replace the driver. 

When Setup opens from your Utilities disk 1, click Update. Make sure that 
the SCSI device number in the dialog box matches the priority number of 
the disk chat is not working correctly. If the SCSI device number does not 
show up in the dialog box, there may be a problem with your hard disk 
hardware. Contact your authorized Apple dealer. 

4. When Setup notifies you that the driver has been updated, click 
Quit to exit from Setup. 

-

-
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Testing your hard disk with Setup 

You can use Apple HD SC Setup to tell you whether or not the hard disk is 
functioning properly. (The Test routine checks the hardware only; it can't tell 
you anything about software problems.) A failure means something isn't 
working properly-even though you may not notice anything wrong. You 
may want to run the test every month or so to avoid unexpected loss of 
data. 

The test takes several minutes. The exact length of time depends upon the 
size of your hard disk and your type of Macintosh. 

Testing does not affect the data currently stored on the disk. To run the 
test: 

1. Insert your UtiUties disk 1 and switch on your Macintosh. 

Be sure your hard disk is on. 

2. Open Apple HD SC Setup by double-clicking its icon. 

Make sure the SCSI device number matches the ID number of the disk 
drive that you want to test. If it does not, click Drive until the device 
number and the ID number match. 

3. Click Test. 

A dialog box tells you that testing will take several minutes and cannot be 
interrupted. 

4. Click OK to continue. 

When the test is complete, a message tells you whether the hard disk 
passed or failed. If it fails, have your Hard Disk SC checked by an 
authorized Apple dealer. 

•!• Note: You can also keep a copy of Apple HD SC Setup on your hard disk 
for testing purposes. Just open it and click Test. Do not, however, 
attempt to initialize, update, or partition the hard disk containing the 
Setup program. 

5, Click Quit to exit from Setup. 

Testing your hard disk with Setup 11 



An operating system is a program that 
organizes the actions of the parts of the 
computer and its peripheral devices. 

6. Important 

Standard partitions 

Creating partitions 

This section explains how to use versions 2.0 and later of Apple HD SC Setup 
to create partitions on your hard disk. You need to create partitions if you 
plan to use portions of your hard disk with other (non-Macintosh) 
operating systems, such as Nux®, Apple's version of the AT&T UNI:x® 
system for the Macintosh. 

If you don't need to create partitions, skip this section for now. 

Whenever you partition a disk for the first time, and in many cases when you 
repartition your disk, Setup must erase all the information stored on your 
disk. Be sure to back up all files that you need before attempting to create 
partitions. 6 

Apple HD SC Setup allows you to partition your entire SCSI hard disk 
according to any one of four standard schemes by following this simple 
procedure. Setup automatically removes old partitions when creating new 
standard partitions. 

1. Start your Macintosh using your UtiUties disk 1 as the startup disk. 

2. Open Setup by selecting its icon and choosing Open from the File 
menu, or by double-clicking the icon. 

The main Apple HD SC Setup dialog box appears, as shown earlier in 
Figure 1-1. 

6. Important If you have two or more Hard Disk SC's connected, make sure that the SCSI 
device number matches the SCSI ID indicator number of the hard disk you 
wish to partition. If they do not match, click Drive until they do. 6. 
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Volume is a general term referring to a 
storage device: a source of or a 
destination for information. 

3. Click Partition. 

The Partition dialog box appears. Check to see that the correct disk is 
shown on the right. (See Figure 1-2.) 

Se lee ta pr edefrned disk partrtroning dnd click OK to r epar trtion 
the entire disk. Or select Custom to rndke your own partrtrons. 

MaHrrnurn Mocrnto~h 
Minimum Macintosh 
SO~, Macintosh 
A/ UH Setup 

Figure 1-2 
The Partition dialog box 

M ~ Megadisk 

[ OK 

([ Cancel ) 

4. Select the standard partitioning scheme that you want 

There are four standard partition schemes: 

• Maximum Macintosh. This is the same partition scheme that you 
created when you first initialized your hard disk. The driver is always in 
a partition separate from the Macintosh volume. Use this scheme if 
your disk has been partitioned some other way, and you wish to use 
es.sentially all of your hard disk as a Macintosh volume. 

• Minimum Macintosh. No matter what size your hard disk, this scheme 
allots about two megabytes of disk space to your Macintosh volume 
so you can use it as your startup disk. You can copy your System 
Folder and utilities into this volume. (See "Creating a Startup Hard 
Disk," earlier in this chapter.) You'll need files establishing another 
operating system to make use of the remainder of the disk. 
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• 50% Macintosh. This scheme creates a Macintosh volume using about 
half your disk space, and it sets aside the other half for future use 
with another operating system. 

• A/UX Setup. This scheme creates a minimum Macintosh volume, for 
startup, and other partitions so you can use the Apple Tape Backup 
40SC to restore or install A/UX files. You need an Apple Hard Disk 80SC 
and version 2.0 or later of Apple Tape Backup 40SC to use this scheme. 

5. Click OK. 

As a short cut, you can double-click the partition scheme that you want 
instead. 

In most cases, a dialog box appears, reminding you that partitioning 
erases the infonnation on your hard disk. To continue, click OK . 

.A Warning Partitioning erases all the infonnation on your hard disk . .A 

Custom partitions 

14 Chapter 1: Apple HD SC Setup 

Partitioning begins, and the main Setup dialog box appears, with status 
messages at the bottom. Setup tells you when partitioning is completed. 

Partitioning takes much less time than initializing. 

If you click Cancel, you return to the main Setup dialog box, but no 
partitioning takes place. 

6. Click Quit to return to the desktop. 

Your Macintosh volume is still shown, but it no longer takes up most of 
the disk, unless you selected the Maximum Macintosh partition scheme. 

If you have a special requirement for a partition scheme other than those 
described above, you can use Apple HD SC Setup to create custom partitions 
on your hard disk. Since few users have such a need, you may wish to skip 
the remainder of this chapter. 

Adding a custom partition merely assigns disk space. Frequently, however, 
you must erase or move infonnation-that is, remove, group, or move 
existing partitions-before you create a new partition. 

-
r 
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To add a partition 

Begin by following the first three steps described in "Standard Partitions," 
earlier in this section. Then fo llow these steps. 

1. Click Custom in the Partition dialog box . 

The Custom Partition dialog box appears. On the right are a Done button 
and four functional buttons- Details, Remove, Lock, and Group-­
described later in this section. 

Each partition is represented by a rectangle, with its size, in kilobytes 
shown on the left. Free space, that portion of the disk that is not 
contained in a defined partition, is gray. (See Figure 1-3.) 
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Figure 1-3 
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There must be a section of free space large enough to hold your new 
partition . 

If there is not sufficient free space, remove one or more partitions. For 
example, if you've just initialized your disk, you'll need to remove your 
Macintosh partition. (See "To Remove a Partition," later in this section.) 
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If the free space is divided into sections by existings partitions, with no 
single section large enough to hold your new partition, you need to 
remove a partition or combine the sections of free space by grouping the 
partitions. (See "To Group Partitions," later in this section.) 

Done returns Setup to the main dialog box. 

2. Move the mouse to place the pointer in a gray rectangle 
representing free space, and press the mouse button. 

As shown in Figure 1-4, Setup draws two brackets representing the new 
partition. If you place the pointer in the upper half of the free space 
rectangle, the brackets start at the top of the free space; if you place the 
pointer in the lower half of the free space rectangle, the brackets start at 
the bottom of the free space. 

ApproK. 
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Figure 1-4 
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3. Drag the pointer up or down (holding the mouse button down), to 
adjust the size of the new partition. 

If you move the pointer to the left or right of the rectangle, the brackets 
disappear. 

The size, in kilobytes, is shown on the left. 

4. Release the mouse when you are satisfied with the size of the new 
partition. 

l 
I 

You don't need to be exact. You still have a chance to change it 

Apple HD SC Setup immediately presents the Partition Type dialog box. 
(See Figure 1-5.) You use the left side to select a partition type for the 
custom partition you are creating. You use the right side to adjust its size . 
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Figure 1-5 
The Partition Type dialog box 
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5. Select the partition type by clicking in the list on the left. 

You have up ro ten choices: 

• The Driver. If your hard disk already contains a driver partition, then 
this partition type is not listed. (Ir's not shown in Figure 1-5.) 

• Macintosh Volume. This represents the Macintosh hierarchical file 
system that you use on your hard disk even when you don't create 
partitions. If there is already a Macintosh partition on your hard disk, 
then it isn't listed. (It's not shown in Figure 1-5.) 

• Scratch. Scratch is disk space that you don't normally use while 
working in your Macintosh operating system, but which some 
programs-non-Macintosh as well as Macintosh-may request for use 
as temporary storage. 

• A/UX. There are seven additional partition types, shown in Figure 1-5, 
that can be used when backing up or restoring the A/UX environment 
to an Apple Hard Disk 80SC from the Apple Tape Backup 40SC. 

6. If you wish to change the size of the partition, click in the Adjust 
Size box and type in the correct size in kilobytes. 

You can enter the partition size to the precision of a half-kilobyte (0.5 K). 
Setup will nor allow other fractions. 

You can also change the number by editing in the normal Macintosh 
fashion. 

The maximum possible size is shown below the Adjust Size box; if you've 
selected a partition type, the minimum possible size is shown above. 

7. CllckOK. 

Apple HD SC Setup creates the new partition and again presents the 
Custom Partition dialog box, where the new partition is shown. 

You can create another custom partition as long as you have sufficient 
free space, but you can only select a listed partition type. 

Click Cancel in the Partition Type dialog box if you wish to return to rhe 
Custom Partition dialog box without creating a new partition. 
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8. Click Done in the Custom Partition dialog box to return to the 
main Setup dialog box. 

9. Click Quit to retu.rn to the desktop. 

Your Macintosh volume is shown, represented by a hard disk icon. When 
you open the window representing the hard disk, its new size is displayed 
just below the title bar, if you are using the By Icon view. 

To remove a partition 

You remove existing partitions to make space for new custom partitions. 
Working in the Custom Partition dialog box, you can remove any partition 
from your hard disk. 

A Warning Don't remove the driver partition unless you have a special reason. Without 
the driver partition you won't be able to use your disk after restarting your 
Macintosh. A 

To remove a partition, follow these steps: 

1. Select the partition you wish to remove by clicking in its 
rectangle. 

2. Click Remove. 

An alert box asks you to confirm that you want to erase the information 
in the partition. 

A Warning Removing a partition erases all information in the partition. A 

3. Click OK. 

Click Cancel if you decide not to remove the partition. 

When a partition is removed, the space it occupied becomes gray to 
represent free space. If another area of free space is adjacent, the two 
gray areas are combined. 
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To group partitions 

Grouping partitions combines the free space on your disk. It's like sliding 
books together so you can place a stereo on your bookshelf. The procedure is 
simple: 

1. Working in the Custom Partition dialog box, click Group. 

Setup presents an alert box, warning that it will take time to move 
information from one portion of your disk to another. Because grouping 
usually means that a large amount of information is being moved, Setup 
also warns that some might be lost. 

2. ClickOK. 

All partitions are grouped together on the disk, and they are shown 
together at the top of the Custom Partition display. 

Click Cancel if you decide not to group the partitions. 

To move a partition 

You can also use the mouse to move a partition into adjacent free space or 

.-. 
i 

into any free space larger than the partition. Follow these steps. i-t 

1. Working in the Custom Partition dialog box, select the ,-.. 
partition. 

2. Holding down the mouse button, drag the partition to its new 
position. 

Setup won't let you move a partition "just a little bit" into an adjacent 
free space. You must drag it more than half way. 

When you release the mouse button, Setup presents an alert box, warning 
that it will take time to move information from one portion of your disk 
to another. Setup also warns that some information might be lost in the 
process. 

3. Click OK to confirm. 

Click Cancel if you decide not to move the partition. 
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To lock a partition 

While your Macintosh partition is locked you cannot alter or erase the 
information it contains, but you can still read the information. To lock the 
Macintosh partition, follow these steps: 

1. Working in the Custom Partition dialog box, select the 
Macintosh partition by clicking in its rectangle. 

2. Click the Lock button. 

This is just like sliding the locking tab on a 3.5-inch disk. In some cases 
Setup warns that the partition will not be locked until you next restart 
your Macintosh. 

When the partition is locked, the lock icon to the left of the rectangle is 
closed. The Unlock button replaces the Lock button. 

Click Unlock to unlock the Macintosh partition, after selecting it. 

To view your partitions 

You can also use Apple HD SC Setup to display a list of partitions on your 
hard disk. Follow this simple procedure: 

1. Working in the Custom Partition dialog box, click the Details 
button. 

The Details window (shown in Figure 1-6) appears. It shows each 
partition, its name, type, size in kilobytes, and the block where the 
partition begins on the disk. At the bottom of the window, the total disk 
capacity is displayed. 

The Details window shows one more type of partition, the partition 
map, which contains information about the partitions on the disk. You 
cannot directly change the partition map, and it takes up a very small 
portion of the disk. 
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Figure 1-6 
The Details window with highlighted partition 

If you select a partition before clicking Details, that partition is 
highlighted in the Details window. If you select a partition in the Details 
window by clicking one of its lines, the partition is highlighted when you 
return to the Custom Partition dialog box. You can't select the partition 
map. 

2. Click OK to close the Details window and return to the Custom 
Partition dialog box. 

-

--



- c H A 

---

-

--
-
-
-
-
--
--

p T E R 

HD Backup 

HE APPLICATION HD BACKUP, FOUND ON YOUR Ulll177ESDISK 1, LETS YOU 

protect the contents of your hard disk by making backup copies of your 

files on 3.5-inch disks and, if necessary, by restoring those files onto the 

hard disk. 

One of the hardest lessons any computer user learns is that it is important to 

make copies of files in case data or programs are damaged by malfunctioning 

hardware, faulty software, human error, external intervention (such as an 

exploring three-year-old), or mysterious events beyond rational explanation. 
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Approaches to backing up your hard disk 

When you are using only 3.5-inch disks, it is relatively quick and easy to copy 
files or even entire disks onto backup disks and recopy them should the need 
arise. When working with a hard disk with 20 megabytes or more of storage, 
however, reconstructing your entire disk may be difficult. If you share that 
disk with other users, putting your files back together again may be 
impossible without the aid of a backup utility such as HD Backup. 

To protect the contents of your disk, you need to copy the entire contents 
of your hard disk onto several 3.5-inch disks. This is called a global backup. 
It is generally time-consuming. 

At the end of each work day or some other regular period, you need to back 
up your disk again. However, since you probably use only a fraction of your 
disk during any work session, you need copy only the documents that 
you've modified or created recently. TI1is procedure is called an incremental 
backup. 

In each incremental backup, you copy onto 3.5-inch disks all files that you 
have created, modified, or copied onto your hard disk since the last global 
backup. Thus, each time you complete an incremental backup, you create a 
new stack of incremental backup disks. You can back up onto your old stack 
of incremental backup disks or set it aside for your next backup. 

With each incremental backup you increase the amount of information 
stored on your incremental backup disks. When that stack roughly equals 
half your stack of global backup disks, you probably should do another 
global backup. Then you can start all over again with your incremental 
backups. 

When working with an important document, you may also want to copy it 
onto a 3.5-inch disk whenever you save it. You can accomplish this easily 

--

with the Save As command, unless it is too large to fit on one of the disks. -
In that case, you need to use the "Back up a single file" option of HD 
Backup. -
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If you lose the entire contents of your hard disk, you can restore it by 
erasing the hard disk and then copying all the global backup disks back onto 
the hard disk. Then, you can bring it up to date by copying the incremental 
backup disks onto the hard disk. 

If you lose a single file, you can restore it to the hard disk from one of your 
backup disks without copying tl1e entire collection of backup disks. 

Backing up files 

Before you use HD Backup for the first time, it makes sense to copy it onto 
your hard disk. Keep the original or another copy handy, however, since you 
can't use the hard-disk copy to restore the contents of that disk if it is 
damaged. 

A Warning HD Backup does not copy certain files with filenames that begin with a 
period. To avoid problems, make sure that you rename all such files (so that 
they don't begin with a period) before running HD Backup . .&. 

Be sure to collect enough 3.5-inch disks to complete both a global backup and 
successive incremental backups. It can take as many as twenty-five BOOK 
(double-sided) disks to back up an entire 20-megabyte hard disk and about 
half as many- up to twelve or thirteen-for the largest incremental backup. 
You may even wish to use two different sets of global backup disks and 
two sets of incremental backup disks, alternating them in case your machine 
fa ils during a backup. 

A Warning HD Backup erases all information previously stored on your backup disks, so 
make sure that none of them contain documents or programs that you 
need . .&. 
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To carry out a global backup: 

1. Open the HD Backup application by double-clicking its icon. 

You can also select HD Backup and choose Open from the File menu. 

A dialog box appears, instructing you to select a function and a volume. 
Volume is a general tenn referring to a storage device. In HD Backup, it 
means your hard disk in nearly all situations, but it can apply to any 
Macintosh storage device except 3.S-inch disks. 

To the right of each hard disk listed, HD Backup shows the amount of 
disk space in use, in kilobytes. 

----------------·--- -- ----- -- ----
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Figure 2-1 
The HD Backup dialog box 
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2. Click the Volume button in the left column corresponding to the 
hard disk that you wish to copy. 

If you have only one hard disk, it is automatically selected. 

If you have more than five hard disks hooked up to your system, the disk 
you wish to back up may not be listed. In that case, return to the Finder 
and drag to the Trash the icon.representing one of the listed hard disks. 
Then switch off the disk drive. Continue until the disk you want appears 
in the HD Backup window. (Be sure you don't shut down your startup 
disk or the disk you are using to run HD Backup.) 

3. Select the "Back up all files" function in the right column, and 
click OK. 

HD Backup automatically ejects any disk found in your 3.5-inch disk 
drives. 

In the lower left, HD Backup reports how many disk sides ( 400K each) are 
required to complete the backup. 

4. When instructed by the dialog box, insert the first disk from your 
global backup stack into one of your 3.5-inch disk drives. 

If the disk is unreadable, the program asks you to eject it or initialize it as 
one-sided or two-sided. Click the appropriate button. 

You can reinitialize a readable disk by holding down the Option key as you 
insert the disk. While this is generally unnecessary, you may do it, for 
example, to reinitialize at SOOK a double-sided disk that was initialized 
at400K. 
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HD Backup automatically names each disk with a number and the name 
of the hard disk being backed up. The first backup disk for a volume 
named Megadisk is always l.Megadisk, followed by 2.Megadisk, and so 
on. 

HD Backup always reports when it's waiting, initializing a disk, verifying 
a disk, or backing up files. It displays the name of each file as it is copied. 

As each disk is filled, HD Backup ejects it and requests the next one. A 
black line moves across the "Percent complete" bar at the bottom of the 
window, indicating the percentage of the global backup that is 
completed. In addition, HD Backup subtracts one or two from the "Sides 
required" display, depending upon the size of the disk just ejected. 

Click Cancel to halt the backup at any point. If you cancel, you cannot 
restore files from the backup disks that you have already created. You can 
either click Quit to exit from HD Backup or proceed again by selecting the 
volume and function and clicking OK. 

5. Label the disk with its assigned name as well as the date. 

6. Insert the next disk. 

If you insert any of the disks that you have just copied files onto, HD 
Backup ejects it and requests another. 

•!• User's tip: If you have more than one 3.5-inch disk drive, you can save 
yourself a linle work by inserting disks into all drives at once. HD 
Backup copies onto the disks in the order of their priority. (If you have 
internal and external 3.5-inch drives, the internal drive always has the 
higher priority. If you have two internal drives, the lower drive or the 
drive on the right has the higher priority.) 

Label each disk and insert another one, as requested by the dialog box. 

7. When HD Backup reports that the backup is complete, click OK 
and then click Quit to exit from the program. 

8. Label your backup stack and store it in a safe but accessible place. 
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Incremental backup The procedure for an incremental backup is similar to the global backup 
sequence described above: 

1. Open HD Backup. 

2. Select the correct volume. 

3. Select the "Back up changed files" function and click OK. 

Any document or file that has been created, modified, or moved to the 
hard disk since the last global backup is copied. 

Some applications, such as MacWrite, actually change when they are 
opened, so files may unexpectedly end up on your incremental backup. 

!::,. Important Incorrect dates are recorded whenever you create or modify a document 
while the Macintosh clock is set on the wrong date. Any document that has 
an incorrect Date Created or Date Modified, recorded as a future date, is 
copied every time you run "Back up changed files." From the Finder, you can 
select a document and choose Get Info from the File menu to check the 
dates. If the problem is only with the Date Modified, you can reset it by 
saving a minor modification to the document. 6 

When you select "Back up changed files," HD Backup does not display 
"Sides required," but the "Percent complete" bar shows the percentage of 
a full backup that you've completed. 

4. When HD Backup is ready, insert the first disk from your 
incremental backup stack into a 3.5-inch disk drive. 

If you have more than one 3.5-inch disk drive, you can insert more than 
one disk at a time. 

HD Backup names each disk by adding a number after the name of the 
hard disk. That is, the first incremental backup disk for a volume called 
Megadisk is Megadisk.1, the second is Megadisk.2, and so on. 

If you click Cancel, you cannot restore files from the backup disks that 
you have already created. 

5. As each disk is ejected, label the disk with its assigned name as 
well as the date, and insert the next disk. 

Repeat as often as necessary. 
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6. When HD Backup reports that the backup is complete, click OK 
and then click Quit to exit from the program. 

When the "Percent complete" bar shows more than 50 percent at the 
completion of an incremental backup, it's time to do another global 
backup. 

7. Label your backup stack and store it in a safe but accessible place. 

By specifying the "Back up a single file" function of HD Backup, you can 
copy a file too large to be copied with the Finder. 

1. Open HD Backup. 

2. Select the volume containing the file you wish to copy. 

3. Select the "Back up a single file" function and click OK. 

A dialog box appears, similar to those that appear when opening 
documents from an application. 

-
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Figure 2-2 
"Back up a single file" dialog box 
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4.. Use the dialog box to locate the file you want to copy. 

See the Appendix, "Moving Through the File System," or your Macintosh 
System Software User's Guide to learn how to use a directory dialog box to 
locate files. 

5. Select the name of the file you want to copy and click Open (or 
double-click the filename). 

HD Backup asks you to insert a disk. 

6. Insert the first backup disk or, if you have more than one 3.5-inch 
disk drive, insert disks into each. 

Neither "Sides required" nor the "Percent complete" bar operates with the 
"Back up a single file" function. 

HD Backup names each disk as if it were doing a global backup, placing a 
number before the hard disk name. 

If you click Cancel, you cannot restore files from your backup disks . 

7. As each disk is ejected, label its assigned name as well as the date, 
and insert the next disk. 

Repeat as often as necessary. 

8. When HD Backup reports that the backup is complete, click OK 
and then click Quit to exit from the program. 

Since the "Back up a single file" feature uses the same naming procedure 
as "Back up all files, 11 you should label these disks to distinguish them 
from those in your global backup stack. 

9. Store your backup disks in a safe but accessible place. 
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Restoring fdes 

Use HD Backup to copy your files from your backup disks to any hard disk. 
Files and filenames on backup disks differ from those on disks created using 
the Finder, so you can introduce errors by using the Finder to restore your 
files. (See the section "When Your Restoration Fails" later on for instructions 
on using the Finder when you are unable to use HD Backup to reconstruct 
the contents of your hard disk.) 

HD Backup shows icons for all copied files, even if the directory from which 
they were copied is arranged by another view (using the View menu in the 
Finder). 

During Backup, HD Backup changes filenames that appear more than once 
on your hard disk (in separate folders). For example, two files named Dear 
John become Dear john.1 and Dear john.2. 

HD Backup packs your files into every available sector of disk space, so some 
files are split into two pieces (or more, in the case of very large files) and 
renamed. For example, if your file called Poem is being copied onto a disk 
when the disk becomes full, that piece is renamed l .Poem. The first file on 
the next disk is 2.Poem. (The split files also have distinctive icons, a sample of 
which is shown here, so you can tell they're incomplete.) 

... 
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Use HD Backup to restore a single file from your backup disks to your hard 
disk without erasing or reorganizing the hard disk. 

1. Open IID Backup. 

2. If you have more than one hard disk connected, select the correct 
volume. 

3. Select "Restore a single file" and click OK. 

HD Backup ejects any 3.5-inch disks in your machine and asks for a 
backup disk. 

4. Insert one of your backup disks. 

You can restore files from any disk created with HD Backup's three 
backup functions. 

HD Backup presents a dialog box containing a file directory for your 
backup disk, as well as buttons for ejecting disks, switching drives, 
opening a ftle, or canceling the Restore command. Every ftle and piece of a 
file on that disk is shown, in numerical and alphabetical order. Folders, 
however, are not displayed. 

Figure 2-3 
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"Restore a single file" dialog box 
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Look in the file directory, scrolling if necessary, for the file that you wish 
to restore. 

If the file you are searching for is not on the diskt click the Eject or Drive 
button and insert another disk. Repeat the search until you locate the file. 

If, in the course of locating a file, you notice the placement of other files 
chat you think you may wish to restore latert note them on the disk label. 

5. Select the name of the file you wish to copy, and click Open. 

You can also double-click the filename in the directory. 

If HD Backup split the file into two or more pieces, find, select, and open 
the first piece. (Remember, the first piece of a file called Poem is named 
I.Poem.) 

When the first piece is copied, HD Backup asks for the disk containing the 
second piece. As soon as you insert that disk, HD Backup automatically 
continues the restoration. 

If your file is large enough to be spread onto three or more disks, repeat as 
often as necessary. 

6. When the restoration is complete, click OK and then click Quit to 
return to the Finder. 

If you wish to restore another file or to back up files, click a function 
button instead of Quit. 

7. Use the Finder to move the file to the proper folder. 

HD Backup automatically restores a single file to the hard disk window. 
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Replacing the entire contents of a hard disk takes time, so you should be sure 
that the contents of your disk are seriously damaged before using "Restore 
all files." 

1. Start up your Macintosh from a 3.5-inch disk (or a hard disk other 
than the one you are reconstructing). 

2. Open IID Backup from a 3.5-inch disk (or another hard disk). 

3. If necessary, click the Volume button for the hard disk onto which 
you wish to restore your files. 

4. Select "Restore all files" and click OK. 

HD Backup warns you that it erases the selected hard disk. 

5. Click OK if you wish to continue. 

If you don't want to erase the disk, click Cancel instead. 

The dialog box requests that you insert your disks, naming them in order. 

6. Insert your global backup disks. 

HD Backup ejects disks inserted in the wrong order or not belonging to 
the right set of backup disks. 

If you have more than one 3.5-inch drive, you can insert disks into each 
one. 

7. When all the global backup disks have been copied, insert your 
incremental backup disks, in order, one or two at a time. 

HD Backup replaces files-from the global backup-with any modified 
versions of the same files. 

If you have no incremental backup disks, simply click both Cancel and 
Quit. 

8. When HD Backup reports that the restoration is complete, click 
OK and then click Quit. 

Restoring files 



When your restoration fails If you are unable to restore all the ftles to your hard disk with "Restore all 
files," but you still have your backup disks, you may be able to salvage much 
of the contents of your disk. This procedure does not reconstruct your 
folders, however, and it should be used only if all else fails. 

Chapter 2: HD Backup 

1. Use the Finder to copy files that are not split from your backup 
disks to your hard disk. 

2. Use "Restore a single file" to copy onto the hard disk files that 
are split onto more than one backup disk. 
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T E R 3 

Disk First Aid 

D ISK FIRST AJD™ IS AN APPLICATION PROGRAM, FOUND ON YOUR UUlI/1ES 

disk I, that allows you to make minor repairs to a damaged disk. You can 

use Disk First Aid when you have a disk emergency-that is, when your disk 

appears unreadable-or for preventive maintenance. 
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Preparing a Disk First Aid disk 

For Disk First Aid to work properly in all cases, you should prepare a disk 
ahead of time, with Disk First Aid set as the startup application. 

1. Copy your System Folder and Disk First Aid onto a 3.5-inch disk 
that you plan to set aside as your Disk First Aid disk. 

You can make your Ulilities disk 1 the Disk First Aid disk by carrying our 
the next step, but that might make it harder to use the other Utilities 
disk 1 application programs. 

2. Select Disk First Aid (in the window representing the Disk First 
Aid disk) and choose Set Startup from the Special menu. 

If for some reason you need to undo the Set Startup command, select the 
Finder icon (in the System Folder) and choose Set Startup again. 

3. Store your Disk First Aid disk in a spot where you can find it in a 
disk emergency. 

When to use Disk First Aid 

Disk First Aid is a program designed to help you regain the use of any disk 
that uses the Macintosh hierarchical file system-that is, a hard disk or 
double-sided (800K) disk-without losing the information and programs 
stored there. 

It requires two steps. First, it examines, or verifies, your disk. Second, it 
repairs damaged data structures. Data structures organize the various files 
and documents on the disk. 

-
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You know that you need to run Disk First Aid when you see a worrisome 
error message telling you a disk is damaged and asking whether you want to 
initialize it. Less frequently, you might see a message asserting that a disk is 
not a Macintosh disk. Such messages might be caused by a power 
interruption or by an application program that causes a system failure. 

In addition, if most of your available disk space disappears following a power 
outage, you may wish to run Disk First Aid, even if you have no other 
problems with your disk. 
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Figure 3-1 
This is when you need Disk First Aid 

If, after you've used Disk First Aid, you still have problems with your disk, 
you may need to reinitialize it and reconstruct your files from backup disks. 
This is a last resort. Run Disk First Aid first, particularly when you're having 
problems with a hard disk. 

•!• Note: If you cannot start up your Macintosh using the hard disk as the 
startup disk, the problem is likely with the System file, not the disk data 
structures. In such cases, you should use another startup disk and copy 
the System file onto the hard disk again. If you normally use an internal 
hard disk as the startup disk, and you are unable to start up your 
Macintosh, you can instruct the computer to ignore the internal hard disk 
and look for another startup disk by pressing the Command, Option, 
Shift, and Delete keys (four keys) at the same time. 
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Examining or repairing your hard disk 

Follow these steps to examine or repair your hard disk: 

1. Start up with your Disk First Aid disk as the current startup disk. 

Your system automatically opens Disk First Aid and presents a dialog box. 

If you haven't set up a disk where Disk First Aid is the startup 
application, you can attempt to open Disk First Aid from the Finder. It 
should work in most, but not all, cases. 

To use the menus, close the dialog box by clicking Cancel. You can reopen 
the dialog box by choosing Open Volume from the File menu. 

•:• User's tip: You may wish to set Disk First Aid for automatic repair by 
choosing Repair Automatically from the Options menu. (You can tum 
off the option by choosing it again.) 

2. Open the disk volume- in this case the hard disk-you want to 
examine or repair. 

You can move to a volume by clicking Drive (or pressing Tab) until its 
name appears in the dialog box, and then click Open (or press Return). 

If you cannot find the volume, the hard disk itself may be damaged or 
malfunctioning. Contact your authorized Apple dealer. 

If somehow you open the startup disk or the disk from which you are 
running Disk First Aid, Disk First Aid tells you that it can examine the disk 
but not repair or erase it. Click Cancel if you wish to open another volume. 
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Figure 3-2 
Opening the volume Hard Disk 
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3. To examine the open volume, click the Start button. 

Once you have started, you can stop or pause the process by clicking the 
appropriate button. If you click Stop, Disk First Aid asks if you really 
wish to stop (by clicking OK) or to continue (by clicking Cancel or 
pressing Return). 

After you click the Pause button, you have the option of clicking Resume. 

lll'<HhJ to \tart. 
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Figure 3-3 
Examining the volume Hard Disk 

Once the volume Hard Disk is examined, the screen displays one of these 
three messages: 

• Fi nished . No repair necessary. 

• The disk "Hard Disk" needs to be repaired . Do 
you want me to do this? 

This message does not appear if you have chosen Repair Automatically 
from the Options menu. In that case, Disk First Aid simply reports when 
it has completed the repair. 

• Unable to verify status of disk . 

4. To repair a disk with minor damage (see the second message 
above), click Repair. 

As a short cut, you can press Return. 

Disk First Aid reports when the repair is completed. 

If Disk First Aid cannot completely repair your disk, it reports that it is 
unable to complete the repair. 
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5. If your disk is damaged beyond repair, reinitialize your disk or 
contact your authorized Apple dealer for other suggestions. 

You know that the disk is damaged beyond repair if a message appears 
reporting that the status of the disk can't be verified or that repair can't 
be completed. 

•:• Note: If you are running Disk First Aid for preventive maimenance­
that is, without an error message described above in "When to Run 
Disk First Aid"- you might be able to save your files before erasing 
your disk. If the message "Unable to verify status of disk" appears, 
quit Disk First Aid and try to make copies of any files that you want 
to save. Copy them back onto the disk after you initialize it. 

Choose Erase Disk from the Options menu. Click the Initialize button if 
you are initializing a hard disk. 

6. Exit by choosing Quit from the File menu. 

If you wish instead to examine another volume, choose Close and then 

-

Open Volume from the File menu. -

Examining or repairing your 3.5-inch disk 

If you have more than one disk drive, you can also use Disk First Aid to 
examine or repair an 800K disk-that is, a double-sided 3.5-inch disk. Follow 
the steps described above for a hard disk, with the following differences: 

• If you have only one 3.5-inch disk drive, you need to use your hard disk as 
the Disk First Aid disk. Make sure it contains a System Folder and a copy 
of Disk First Aid. 

• When opening the disk volume (step 2 earlier), you can eject a 3.5-inch disk 
by pressing the the Eject button. Then insert the damaged disk. 

• Disk First Aid inspects and attempts to repair a double-sided disk even if 
you can't show it on the desktop. 

• When you choose Erase Disk from the Options menu (in step 5 earlier), 
dick Two-Sided if you want your reinitialized disk to use the hierarchical 
file system. 
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p T E R 4 

Font/DA Mover 

E NT/DA MOVER IS AN APPLICATION PROGRAM TllAT AllOWS YOU TO ADD OR 

remove fonts and desk accessories from any System file. It is found in the 

Font/DA Mover Folder on your Macintosh Utilities disk 2. 
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About fonts and desk accessories 

Fonts and desk accessories are contained in your startup disks' System files. 
Fonts are the typefaces and type sizes that can be used by the Macintosh 
and its application programs. Desk accessories are mini-applications that you 
can open from the Apple menu. The fonts and desk accessories that you can 
work with depend upon which startup disk-that is, which System 
file-your Macintosh is currently using. This current startup disk is usually 
shown in the upper-right corner of your desktop. For a more complete 
discussion of startup disks and current startup disks, see your Macintosh 
System Software User's Guide. 

•!• Note: Each type size for a font is stored and listed separately. Thus, when 
this manual describes copying or removing a font, it is referring to a 
specific size of a font, such as Geneva 10. 

Other fonts and desk accessories, as well as those stored in the startup 
System file, can be stored in other System files or in special font files and 
desk accessory files. The font file in the Font/DA Mover Folder on your 
Macintosh Utilities disk 2, for example, contains several fonts. Find File is 
stored in the desk accessory file found in the same Font/DA Mover Folder. 

A font file A desk accessory file 

Figure 4-1 
Icons representing font and desk accessory files 

You can use Font/DA Mover to copy fonts and desk accessories to and from 
any System file, including the current startup System file. 

You can also copy fonts to or from a font file and desk accessories to or 
from a desk accessory file. In fact, you can use Font/DA Mover to create 
font and desk accessory files. 
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If you consider your System file too large, you can use Font/DA Mover to 
remove fonts and desk accessories. If you don't have them backed up 
elsewhere, however, it makes sense to copy them to another disk instead. 

Like other applications, Font/DA Mover can be copied to and opened from 
almost any disk. 

Moving fonts and desk accessories 

Font/DA Mover works the same for both fonts and desk accessories. You 
are likely, however, to want to move only one desk accessory at a time, while 
you probably need to copy several fonts- such as a family of different sizes 
of the same font- at once . 

To be sure that Font/DA Mover works properly, turn off MultiFinder before 
removing fonts or desk accessories, or copying a large number of fonts. 

To tum off MultiFinder, choose Set Startup from the Special menu. Click the 
Finder button and then OK in the dialog box that appears, and restart your 
Macintosh. !.:::. 

When MultiFinder is turned on, you can't use Font/DA Mover to remove 
fonts from the System file of your startup disk or to remove or replace an 
open desk accessory. Furthennore, if you leave MultiFinder on, there might 
not be enough memory available to move a large number of fonts. You can, 
however, use Font/DA Mover with MultiFinder to install fonts and desk 
accessories. 
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1. Select the Font/DA Mover icon and choose Open from the File 
menu, or just double-click the icon. 

The Font/DA Mover dialog appears, with the Font button selected at the 
top. Listed on the left are the fonts included in the current startup 
System ftle. 

You can hold down the Option key while opening Font/DA Mover to 
select the Desk Accessory button and show the desk accessories in the 
current startup System file. 
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You can also open Font/DA Mover by selecting the icon of any font or 
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desk accessory ftle and choosing Open from the File menu, or by double- .... 
clicking the icon. In this case, the list on the left shows the contents of 
the selected file. If you open a desk accessory ftle, the Desk Accessory ""' 
button is automatically selected. 
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2. Click either the Font button or the Desk Accessory button, 
depending on what you want to add or remove. 

If the Font button is selected, the list representing any open file, on the 
right or the left, contains fonts only. If the Desk Accessory button is 
sele~ted, the list representing any open file contains only desk accessories. 

3. Use the Open buttons to present lists of any other System, font, 
or desk accessory files. 

If necessary, frrst click Close to close the file currently displayed. Each 
Open button lets you control what's displayed in its list. Both the ftle 
you're looking at and the disk it's on are shown below each list. 

Whenever you click an Open button, a dialog box appears with a directory 
of folders and System, font, and/or desk accessory ftles on the current 
disk or in the current folder. (See Figure 4-3.) Use that dialog box to switch 
disks or move up, down, or across your file hierarchy. See the Appendix, 
"Moving Through the File System," or your Macintosh System Software 
User's Guide for more details on how to use the directory dialog box. 
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Figure 4-3 
Dialog box for locating System files and locating or creating font or 
desk accessory files 
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4. Open the file you want to look at by selecting its name and then 
clicking Open, or by double-clicking its name. 

You can look at and work with any existing System, font, or desk 
accessory file. 

You can create a new file for storing your own collection of fonts or desk 
accessories by clicking New, naming the file, and clicking Create. 

5. Select the fonts or desk accessories you want to copy or remove. 

You can select from either list. Click to select a single font or desk 
accessory. While holding down the Shift key, click additional single fonts 
or desk accessories, or drag to select a group. Shift-dick to deselect a 
selected file. The number of bytes selected is displayed as well as the 
amount of space available on the disk. Both the name of the current file 
and the name of the disk it's on are displayed below each list. 

When a single font is selected, the name, size, and a sample of the font are 
shown at the bottom of the window; when more than one font is 
selected or when a desk accessory is selected, nothing is displayed there. 

6. Click Copy to copy the selected fonts or desk accessories in the 
direction the arrows point, or click Remove to remove them. 

Clicking Copy copies the fonts or desk accessories to the opposite file; 
clicking Remove removes them from the file they're in. If a font or desk 
accessory with the same name as the one you selected already exists in 
the opposite list, it is replaced by the selected font or desk accessory. If 
you remove all fonts or desk accessories from a font or desk accessory 
file, the file itself is gone the next time you click Open. You can't remove 
from a System file certain fonts that the system needs. 
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Copying a selected font with Font/DA Mover 

Only fonts and desk accessories in the current startup disk's System ftle 
are available to applications you use with that disk. You're limited to 15 
desk accessories in a System file. 

7. Click Quit 

On the desktop, you can drag any font or desk accessory files you no 
longer need to the Trash, or copy or move these files between disks. 
Opening any font or desk accessory file automatically opens the Font/DA 
Mover. 

You can use the Font/DA Mover to create an auxiliary set of fonts or desk 
accessories. Later you can move the current System ftle fonts or desk 
accessories to another font or desk accessory file you create, and then 
copy the auxiliary file to your System file. You can use the Font/DA 
Mover to alternate between the two files (or any others you create) 
whenever you want. 
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c H A p T E R 

Find File 

~ 
IND FILE IS A MACINTOSH DESK ACCESSORY THAT HELPS YOU LOCATE FILES ON 

your disks. \Vhen you use the hierarchical file system to store a large 

number of files-including documents, application programs, folders, system 

files, and accessories-you may find it difficult to recall what you've named 

your documents or to figure out where you've placed your files. Find File 

helps you do both. 
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When Find File is installed, you can use it to search for a file by specifying the 
entire filename, a keyword found in the name, or a sequence of characters 
contained in the name. 

To help identify the proper file, you can instruct Find File to display essential 
infonnation about any item found in a search. To help you use the file, Find 
File also shows the hierarchical chain of folders indicating where it's stored 
on the disk, and it allows you to move the file to your desktop. You can also 
use Find File as a short cut to open a specific document while you're using an 
application program. 

Find File can search for files on hard disks and 3.5-inch disks. It works on 
double-sided disks (SOOK) just as it does on hard disks, but it does not 
recognize folders on single-sided ( 400K) disks. 

You can use Find File to search within specified folders or on other disks. And 
you can conduct searches "in the background." That is, Find File can continue 
a long search even while you are working in an application. 

lnsta11ing Find File 

Use the desk accessory option of Font/DA Mover to install or update Find 
File, which is found in the Desk Accessory File in the Font/DA Mover folder 
on your Utilities disk 2. (See Chapter 4.) Once installed, Find File appears as a 
desk accessory on the Apple menu at the upper-left corner of your screen. 
You can also copy a current version of a System file that contains Find File 
onto your startup disk. 

-
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Searching for ftles 

You can search for files while you're using che Finder or an application. 
Follow these five steps: 

1. Choose Find File from the Apple menu. 

The Find File window appears on che screen, wich che insertion point 
blinking in che "Search for" box. 

The Find File menu appears at che right side of che menu bar. 

"Halt' bunon ---------------=-=----=-=-=========--=-------=----:= =-----.,,, 
Find File menu f 11e Edit Llieui Spec 1a1 inti 111e 

Close box-----------...,.._~~=~~iiii~ii~5rr;-;in~d r11e ~~~~~~i~~~~~-1 
Search region -------------~ llMd Disk lf.lii1 
Character sequence ---------++- -----....r----- IH!!li 

Set.11th fm: JOhn 
•search for• box - ---------++-------1 I !\ I 
"Walk" button --------d!------=====~'========-=----=-----=======::Y 

~ Dh• Jot.r.: 

"""' List of matching filenames --------t 

- Selected filename ----------=j!a:iiimL::::'.======-:==========~::::E~ 
_,July 

-

-
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Information about selected file -----l , Reminder\ 
, Smith\ 

Chain identifying placement _____ _J!.::::=============7" ~ L 011 e\ponclen 
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Scroll bar for viewing ---------+- ---------------J 
additional matched filenames 
Scroll bar for viewing--------------------------~ 
remainder of chain 

Figure 5·1 
Features of Find File 
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2. Select the search region. 

The search region-the disk or folder to be searched-is shown in the 
upper-left comer, just below the close box. \Vhen you open Find File, the 
search region is preset as the disk from which Find File is operating-the 
current startup disk. In the example in Figure 5-1 , the search region is Hard 
Disk. (See your Macintosh System Software User's Guide for more about 
startup disks.) 

You can use Find File to search any disk. If you think that searching the 
entire disk will take too long, you can specify that Find File search only a 
specified folder. 

Use one of the following three methods to select the search region: 

• To search your entire current startup disk, go to Step 3. 

• To search another disk, click the disk icon shown to the left of the 
search region's name: a different disk's name should appear. Click again, 
if necessaiy, until the name of the desired disk appears. If you want to 
select a 3.5-inch disk, be sure to insert it first. 

If you have a one-drive system, use the method described next, 
specifying another disk as the directoiy title. 

• To search within a specified folder, choose Search Here from the Find 
File menu (or press Command-H). A directoiy dialog box appears. Click 
Drive to switch drives, or click Eject and insert another 3.5-inch disk 
to switch disks. Select the folder you want to search and click Open 

Folder. When the folder's name appears above the directoiy list as the 
directoiy title, click OK. 

You can use the directoiy dialog box to move down, up, or across your 
ftle hierarchy when specifying the Search Region. See the Appendix, 
"Moving Through the File System," or your Macintosh System Software 
User's Guide for more detailed instructions. 

When you click OK, you return to the Find File window. The directoiy 
title, not the selected folder in the directoiy list, becomes the search 
region. 

When you click Cancel, you return to the Find File window. The search 
region is unchanged. 

----
-
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3. To search, type any sequence of characters. 

Find File attempts to match any sequence of characters that you 
type-letters, digits, or other keyboard symbols- with one or more 
filenames. 

When it searches, Find File makes no distinction between uppercase and 
lowercase letters, and it searches for the character sequence regardless of 
where it appears in a filename. 

Find File's Search function interprets a space to mean "and." That is, each 
word is treated as a separate character sequence. For example, if you type 
Dear John, it looks for any filename containing both "Dear" and 
"John," such as Dear John, Dear Old John, or Johnson's Dear. On the other 
hand, it does not look for To John or Dear Jane. 

llat d Dt~k 

D D•a.- John2 

D D•ar John 

D D•ar John2 

D DE AR OLD JOHN 

D Johnson's: Dear 

Figure 5-2 

r::--­
Dear Joh~ 

Matching text with filenames in Find File 

•:• User's tip: Avoid including articles (a, and, the) and small prepositions 
(such as to, for, of) in your character sequences. If you specify To 
John, for example, Find File does not locate the file named Letter For 
John. 

You can modify any character sequence using standard Macintosh editing 
steps-that is, by moving the insertion point, by pressing the Delete key, 
or by selecting any character or characters. 
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4. To start a search, click the button with the "walk" icon on the 
right side of the Find File window. 

You can press Return or Enter as a short cut. 

5. To end a search, click the button with the "halt" icon. 

Once you have ended a search, you can't continue where you left off. 
(Clicking "walk" again restarts the search at the beginning.) 

You can type a new character sequence and begin a search whenever the Find 
File window is displayed, unless a search is already in progress. 

As Find File locates files matching the "Search for" character sequences, it 
lists them along the left side of the window. Next to each filename, it also 
displays a small icon identifying the file as a document or system file, an 
application, or a folder. 

Should it find more than five matching filenames, Find File activates a scroll 

-

bar at the right side of the window so you can scroll other matching ~ 

filenames into view. Find File also displays filenames more than once if they 
appear in more than one folder. (See, for example, the Dear John2 files shown ~ 
earlier in Figure 5-2.) 

Searching a disk containing hundreds of files can take some time. To tell you 
that a search is over, Find File beeps; or, if your speaker volume is set at zero, 
the menu bar blinks once. To make sure that you get the message, keep your 
speaker volume at an audible level. 

-

-
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Getting information 

You can display infermation about a file by clicking its filename in the Find 
File window. 
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Figure 5-3 
Selecting a listed ftle to display information 

In the lower-left portion of the window, Find File displays the date and time 
the ftle was created, when it was last modified, and its size. This information 
may help you determine whether the listed file is the ftle that you are looking 
for. 

In the lower-right comer of the window, Find File displays the chain of 
folders that must be followed to get to the file. If a file is nested more than 
four folders deep, Find File activates a scroll bar at the right side of the 
window to let you view the remaining folders. 
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Operating in the background 

Since a search can take several minutes, Find File has been designed to save 
you time by continuing to search for files in the background- while you're """ 
working within an application. To search in the background, follow these 
~~. ~ 

1. Start work in an application program. 

2. Choose Find File from the Apple menu. 

The Find File window appears in front of your work, and the Find File 
menu appears on the menu bar. 

3. To start a search, first type a character sequence, and then click 
the "walk" button. 

Find File displays matching filenames as they are found. 

4. Click the active application window to return to the application 
you are using. 

6 Important Do not click Find File's close box if you wish to run Find File in the 
background. Doing so immediately halts any search that is already in 
progress. , 
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With most application programs you can write, calculate, or carry out 
other operations while the search continues. However, a few applications 
(such as early versions of MacPaint) do not allow you to return to your 
work without closing Find File; others (such as MacDraw) automatically 
close Find File, halting the search, whenever you click the application 
window. 

Find File notifies you that its search is over with a beep. 

5. Redisplay the Find File window by choosing Find File on the 
Apple menu. 

Filenames matching the character sequences that you typed in the "Search 
for" box are now displayed. You can display file information and record it 
for future reference and, if you wish, you can click the application 
window to continue your work. 

..... 
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While working in the 
Finder 

Opening files 

Though Find File does not directly open documents, it is designed to help 
you find and open documents and applications. 

If you're working in the Finder, you can use Find File to move a file to the 
desktop. 

1. Use Find File to find and then select a file. 

2. Choose "Move to Desktop" from the Find File menu. 

As a short cut, you can press Command-M. 

As shown in Figure 5-4, the selected file's icon appears beneath the disk 
icon(s) on the right side of your desktop. 

Se;11 r h for: 

D (• .. .Jr .Jotr1: 

D [) .. 1r t,r,: 
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Figure 5-4 
The document Dear John moved co che desktop 
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While working in an 
application 

6o Chapter 5: Find File 

3. Close the Find File window by clicking its close box. 

4. Open the document or application by selecting its icon and 
choosing Open from the File menu or by double-clicking its icon. 

When you quit the application, the file will still be shown on the desktop. 

To return the file to its original folder, select its icon and choose Put 
Away from the File menu. You can move the file back with Put Away 
even if you change its name, but not if you move it to any other folder or 
to the disk window itself. 

You can also can drag the file's icon back into its original folder, into the 
Trash, or into any other folder. 

If you're working in an application, you can use Find File to help open any 
document that you created using that application. Follow this procedure: 

1. While working in an application, use Find File to find and then 
select a document. 

If MultiFinder is turned on, make sure that the application you want is 
the current application. Then hold down the Option key when you open 
Find File. 

2. If your application allows you to open only one document at a 
time, and a document is open, choose Close from the File menu. 

-

-

-
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3. Choose Open from the application File menu. 

If the Open command is dimmed, close Find File by clicking it close box. 
TI1en Choose Open. 

A directory dialog box appears. The name of the folder or disk containing 
the selected document appears as the directory title at the top. 

Let's say the MacWrite document Dear John is nested in a folder named 
Smith's. If you find and select Dear John with Find File, Smith's 
automatically becomes the directory title when you choose Open from 
the MacWrite File menu. 

= Hard Disk 

Open 

Cancel 

Figure 5·5 
Opening a MacWrite document with the help of Find File 

4. Select and open the correct document from the directory list. 
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Quitting Find File 

You can quit Find File by clicking the close box, by choosing Close from the 
File menu when the Find File window is active, or by entering or leaving an 
application. Quitting Find File halts any search in progress. 

The next time you open Find File, the "Search for" box is blank, and the 
startup disk is shown as the search region. Remember, you don't have to quit 
Find File in order to use an application program. 

-
-

-
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Macro Maker 

t , MACROMAKER™ UTILITY ALWWS YOU TO RECORO CHARACTIRS AND 

commands as macros that you can call upon at almost any time. That is, 

you can play back a recorded macro by typing a keystroke that you assigned 

to the macro when you recorded it, or you can choose the macro you want 

from the MacroMaker menu. In MacroMaker, a macro consists of a script 

and in most cases a keystroke. A script is a recorded sequence of characters 

and commands. A keystroke is a key or a key combination that you press 

to "play" a script. Each macro has a unique name, and it may have its own 

description, called info. 

This chapter introduces you to MacroMaker and tells you how to install the 

utility. Next it shows how to create and use macros. Later it explains other 

ways you can work with your macros and macros files. 
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Ways to use MacroMaker 

With MacroMaker, there are three basic ways you can use macros: 

• You can remap your keyboard by creating a single-character macro. 

For example, you can record as your macro the curly apostrophe (')-it's 
normally typed by holding down the Shift and Option keys while typing 
the right-bracket key ()). If you ass\gn the straight apostrophe (')as the 
key triggering the macro, you'll get the curly apostrophe every time you 
type the straight one. 

• You can record a sequence of characters that you use frequently, such as 
an addres.5 or a legal boilerplate. 

In this use, MacroMaker is similar to the Scrapbook desk accessory, but it 
is quicker. Let's say you are writing a paper about U.S. foreign policy 
during the Carter Administration. You could record a macro consisting of 
the letters in "Zbigniew Brzezinski" and assign it the key combination 
"Option-Z." Then, every time you need to refer to Brzezinski, the National 
Security Adviser, you could automatically type his name, spelled correctly, 
into your document, simply by pressing Option-Z. 

• You can assign your own keystroke short cuts to commands that don't 
already have them. 

For example, if you're using an application, such as MacPaint, that doesn't 
have a keyboard equivalent for the Save command in the File menu, you 
can create a Macro that does exactly that. Just record the process of 
choosing Save and assign Command-$ as the keystroke. 

With MacroMaker, you can place a macro in a list of macros associated with 
the application program you are using. Alternatively, you can place it in a 
global list that you can call upon no matter what application you are using. 
Or you can place it in a list that you've already created while working with 
another application program. 

MacroMaker works on the Macintosh Plus and more recent versions of tl1e 
Macintosh, such as the Macintosh SE and Macintosh II. For MacroMaker to 
work properly, you must be using version 4.1 or higher of the System file. 
The version number is shown in the Comments box at the bottom of the 
Get Info window. To check it, open the System Folder on your current 
startup disk, select the System file, and choose Get Info. 

You can share your macros with any Macintosh user who has MacroMaker 
installed. 

-

-
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To install MacroMaker 

Tape icon, which identifies 
MacroMaker menu 

To remove MacroMaker 

Installing and removing MacroMaker 

MacroMaker appears on your Utilities disk 2 as a folder containing the 
MacroMaker program, the MacroMaker Help file, and a preset macros file for 
use with the Apple Extended Keyboard. 

To install MacroMaker, follow these steps: 

1. Select the MacroMaker folder on your Utilities disk 2 and 
choose Open from the file menu. 

As a short cut, you can double-click on the folder. 

2. Drag the MacroMaker and MacroMaker Help icons from the 
MacroMaker folder into the System Folder on your startup disk. 

3. If you have an Apple Extended Keyboard, also copy the file 
labeled Macros from your Utilities disk 2 into the System Folder 
on your startup disk. 

The file contains macros assigning the keys Fl, F2, F3, and F4 to the Edit 
commands Undo, Cut, Copy, and Paste, respectively, when you are using 
standard Macintosh applications. 

4. Restart your Macintosh. 

The MacroMaker menu, identified by a small tape cassette icon, appears at 
the right of the menu bar whenever the MacroMaker application is 
installed. 

When the MacroMaker Help file is installed, the About MacroMaker 
command in the MacroMaker menu presents a series of screens displaying 
reference information about MacroMaker's commands and windows. 

If you don't need MacroMaker, but you do need the space on the menu bar, 
you can remove MacroMaker by following these steps: 

1. Drag the MacroMaker file from the System Folder to another 
folder or the disk-level directory. 

2. Restart your Macintosh. 

The MacroMaker menu is no longer shown. 

To reinstall MacroMaker, drag the MacroMaker file back into the System 
Folder and restart your Macintosh again. 
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-
Setting up a macros file -

MacroMaker uses macros tl1aC are stored in the Macros file in the System -
Folder of your current startup disk. When you install MacroMaker, it creates 
that Macros file, unless you have already placed a file named Macros in the ~ 

System Folder. Each new macro you create is added to the Macros file. 

Your Macros file can contain numerous macro lists: one global list and one for 
each application program. When the MacroMaker window is closed, you can 
view the global macro list and the list for the current application by pressing 
down on the MacroMaker menu. 

•:• Note: The current application is the one with its menus shown in your 
Menu bar. For MacroMaker's purposes, the Finder is an application 
program, so if you haven't opened an application, the Finder is shown as 
your current application. 

When you create a macro, record its script while working in the application 
program with which you expect to use it. 

This version of MacroMaker records only certain mouse actions, so you 
probably won't be able to record all steps you take in dialog or alert boxes. 
However, because one bunon in most dialog boxes-usually it's outlined in 

-

bold-can be chosen with the Return key, you can record the action it -
represents. 

To record a macro for an application program, follow these steps: 

1. Open a new document in that application program. 

You can also use an existing document, but anything you record is 
entered in u1e document. 

Make sure the application is set to accept menu commands or typed 
characters. For example, if you're recording text in a graphics program 
such as MacPaint, be sure to select first the Text tool. If the application 
is not set to accept commands or typed characters, MacroMaker may 
still record them, but you won't see u1em on the screen. 

2. Open MacroMaker by choosing Open MacroMaker from the 
MacroMaker menu. 

The MacroMaker window appears, with the name of the current 
application shown at the upper right. 

-
-
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You create a macro in the "cassette recorder"-the loaded macro-before 
adding it to rhe macro list for the current application. 

•!• Note: If you want to record a script and don't want to set up the 
macro first, you can start recording by choosing Start Recording 
from the MacroMaker menu. Then, when you choose Stop Recording 
from the MacroMaker menu, the MacroMaker window opens 
automatically. Name the macro and click store if you wish to save 
the script. 

Current application - ------­
O MncroMnlier~ 

Type name of macro here ------ +-.r1 r-.arne: 
'F:==. ==-=====··· =(! 

Type info here - - - ---- ---i--.'-I 
Name of macros file-------~+:=?=:;;;iii~==F~~==;;;:::::+-1---.. 

Frndrr "1a< 1 O\ 

"View by" switch--------11::~~~t§~g~~~~~ 
Assign keystroke here '-----,'""1,.-,-. -t .. -, ----. 

l-~11 _____ 1 _1..._. __ 

Figure 6-1 
The MacroMaker window 

3. Name the macro by typing up to 16 characters on the line labeled 
"Name." 

This is the way the macro will be shown in the MacroMaker menu, so 
choose a brief name that identifies this macro uniquely. 

You can edit the name in the usual Macintosh fashion. 

4. If you wish to create a description of the macro, place the 
insertion point in the info area below the name, and then type a 
phrase explaining what the macro does. 

You can move the insertion point to the info area with the mouse or by 
pressing the Tab key or Return key after entering the macro name. 

5. Select the line labeled "Keystroke" and type the keystroke that 
you want to trigger the macro. 

You can select the keystroke line with the mouse or by pressing the Tab 
or Return key after typing info. 
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Figure 6-2 
Symbols for modifiers 
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You can hold down one or more modifier keys, such as the Command 
key or Option key, while typing a readable character. MacroMaker shows 
symbols representing modifier keys before it shows readable characters. 
One modifier key, Control, is not present on the Macintosh Plus 
keyboard. 

•:• Note: Although there is no key that turns on the numeric keypad, 
numbers typed on the numeric keypad are preceded with the symbol 
shown in Figure 6-2 to distinguish them from the numbers on the 
typewriter-like keyboard. (When modified by the Shift key, the 
following symbols on the Macintosh Plus keypad are identical to the 
keyboard arrow keys:/,•,+, and -.) 

The last key in the displayed keystroke is usually a readable character; it 
is never a modifier key. It is shown as it appears on your Macintosh 
keyboard. For keys with two characters shown, the lower character is 
displayed. The key labeled Backspace on the Macintosh Plus keyboard is 
displayed as Delete, which is how it is identified on more recent Apple 
keyboards. 

Assign a keystroke that is easy to remember but which you don't 
already use to type special characters. 

You can replace the keystroke by typing another one while the line is 
selected. If you don't want a keystroke assigned, you can remove it by 
pressing the Delete (Backspace) key. 

The keystroke is shown to the right of the macro name in the 
MacroMaker menu. If you don't assign a keystroke, the macro will still 
appear in the Macro.Maker menu, and you'll be able to call on it by 

,.... 

----

-

-
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choosing it from that menu. -

6. Click the Record button. 

MacroMaker returns you to the current application program. 

The MacroMaker menu icon blinks to remind you that anything you 
type and any command you choose will be recorded as part of your 
macro. 

7. Enter the script you wish to record. 

If you make a mistake while entering text, you can press Delete 
(Backspace), just as you normally do to erase a character. In this case, 
both the character and the deletion are recorded. 

You can record menu commands in the application you are using, with 
two limitations. 

---
---
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You can record menu commands in the application you are using, with 
two limitations. 

• Although some applications allow you to move horizontally from 
one open menu to the next, when recording with MacroMaker you 
must always open a menu by dragging down from the menu bar. 

• MacroMaker does not recognize changes in menus. The macro 
chooses menu items by position, not by name. 

8. To stop recording, choose Stop Recording from the MacroMaker 
menu. 

This returns you to the MacroMaker window. 

MacroMaker does not include the Stop Recording command in your 
recorded script. 

9. If you want to check your script, click the Play button. 

MacroMaker automatically returns you to the current application, 
repeats the script you've just recorded, and then returns you again to 
the MacroMaker window. 

10. If you are not satisfied with your script, you can record it again, 
using the same macro name, info, and keystroke. 

The old recording is erased by the new one. 

11. Click the Store button to move the loaded macro into the macro 
list. 

If the macro is named and has at least a script or an assigned keystroke, 
it is added to the MacroMaker menu and to the macro list on the 
MacroMaker window's right. If that list already contains a macro with 
the same name or assigned keystroke, MacroMaker asks if you want to 
replace the existing macro or cancel the store command. If you cancel 
the store command, you can always rename the macro or change the 
keystroke before clicking Store again. 

If you close the MacroMaker window while there is still a new (or 
changed) macro in the cassette recorder, MacroMaker asks if you want 
to store the macro before closing. 

If you record a new script without storing the loaded macro, the loaded 
script is permanently lost. .& 
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To create a global macro 
A global macro is a macro that you can cali upon no matter which application 
program is current. Create global macros only for scripts that you expect to 
use within many application programs. 

6. Important Because menus vary from application to application, do not create global 
macros containing menu commands. 6. 
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You can assign the same keystroke to an application-specific macro and to a 
global macro, but when you're using that application the keystroke triggers 
only the application-specific macro, even though MacroMaker still shows the 
global macro in the MacroMaker menu. When you're using other applications, 
however, the keystroke calls upon the global macro. 

When recording a global macro, make sure you're using an application that 
allows you to enter text. The Finder is generally a bad place to record global 
macros, since typing is likely to rename some of your files. If you need to 
work in the Finder, choose Get Info from the File menu and type (while 
recording) your script in the Comment box at the bottom of the Get Info 
window. 

To record a global macro, follow these steps: 

1. Choose Open MacroMaker from the MacroMaker menu. 

The MacroMaker window appears, with the current application shown at 
the upper right. 

2. Move the mouse to place the pointer on the name of the current 
application, and press the mouse button. 

A menu of macro lists appears. 

finder Macros 
Global Macro\ 

MacU111te 4.5 Macro\ 
MacPaint 1.5 Macro\ 

Figure 6-3 
A typical pop-up menu of macro lists 
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A few special scripts 

3. Drag down to Global Macros, and release the mouse button. 

"Global Macros" appears where the current application was shown, and 
the macro list is now the global macro list. 

4. Follow steps 3 through 11 in "To Record a Macro," earlier in this 
section. 

You can create macros to do some surprising things. Here are a few 
suggestions: 

• You can record an "erase text" macro consisting of several Delete 
(Backspace) characters. 

• You can create and store a macro without recording a script. In this case, 
the keystroke triggers no action. 

You may wish to create such a "null" macro if you are using an application 
where a familiar keystroke normally triggers an undesired action. For 
example, in some applications, Command-P is a short cut for the print 
command. If you usually work in MacWrite, where Command-P changes 
the type style to Plain, you may wish create a null macro (for the other 
application) to disable the other application's Print command short cut. 
That way, when you're working in that application, you won't bring up 
the print dialog box every time you press Command-P. 

• When a command requires a delay before you type a confirming key such 
as Return, be sure to record the delay. TI1at is, wait until the dialog box is 
shown on your screen. 

• You can create a macro within a macro. That is, if you've recorded a script 
consisting of more than one keystroke, MacroMaker-at playback- plays 
all the macros called upon by keystrokes contained in that script. 

Let's say you already have a macro that spells out "Zbigniew Brzezinski" 
whenever you type Option-Z. You can create another macro, that types 
"Zbigniew Brzezinski's report," simply by recording a script consisting of 
Option-Z followed by '.5 report. 

6 Important Be careful not to create a closed loop, in which the first macro calls upon a 
second macro that calls upon the first macro. 6 
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• You can record a macro to help you quit your work in a hurry. For 
example, if you normally work with one application open, and you expect 
to save your changes when you finish, then you can record a macro 
consisting of Command-Q, a return character, and the Shut Down 
command from the Finder's Special menu. 

In most application programs, Command-Q calls upon the Quit command. 
The Return key tells the computer to save the changes you've made in 
your document (if you've already named the document). Shut Down 
turns the computer off after the document is saved. 

If you're working on a long document, the process of manually saving it 
to your disk may take a long time. However, if you record a script that 
ends with the Shut Down command, MacroMaker can do the waiting for 
you, while you rush off to answer the phone, attend a meeting, or feed 
your baby. 

When you record the Shut Down command, your Macintosh shuts down 
after you manually instruct MacroMaker to store the macro and close the 
MacroMaker window. 

Using your macros 

You can call upon the macros you've recorded at almost any time. This is the 
simplest, yet probably the most frequent way that you'll be using 
MacroMaker. 

First, make sure that MacroMaker is installed and turned on. If the 
MacroMaker menu is not shown at the right of the menu bar, install 
MacroMaker as described earlier in "To Install MacroMaker." If all macros and 
commands iri the MacroMaker menu, except Open MacroMaker and About 
MacroMaker, are dimmed, that means MacroMaker is turned off. Turn 
MacroMaker on (as explained later in "To Turn MacroMaker Back On"), and 
then close the MacroMaker window. 

-

-

--

•:• Note: If there are so many menus in the Menu bar that the MacroMaker -
menu doesn't fit, you may wish to close other desk accessories so there is 
~~~fil -
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The MacroMaker menu lists all available macros-that is, all macros that you 
can call upon at the time. The macros for the current application are listed 
above the global macros . 
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Figure 6-4 
A typical MacroMaker menu 

Each macro is identified by its name and, if you have assigned one, its 
keystroke. If you have assigned an application-specific macro the same 
keystroke as a global macro, the keystroke is shown with both, but you can 
use it only to activate the former. 

•!• Note: If an assigned keystroke normally appears as a short cut in one of 
the application program's own menus, it is still shown, but it no longer 
activates ci1e command with which it is listed. 

If you have more macros than fit in the MacroMaker menu, you can scroll 
them into view by dragging down from the bottom of the menu. 

Before you call upon a macro, be sure that it will have the intended effect. 
For example, if a macro contains a Tab, your text may jump to the wrong 
position if you've moved the tab stop in your document. 

Or, if your macro is designed to replace existing text, the text will just be 
added if the existing text is not highlighted first. You may run into this 
problem if you're recording a macro to carry out a search command in some 
applications. 
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To call upon a macro 

To interrupt a macro 
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There are cwo ways to call upon a macro: 

• Type its assigned keystroke. 

• Choose the macro from the MacroMaker menu. 

MacroMaker "plays" the script that you call upon, "typing" characters and 
choosing commands. 

When the macro is finished playing, you can continue working in your 
application. 

•:• Note: You can call upon a macro and continue typing immediately, 
without losing the text that you enter while the macro is still playing. 
Anything that you type is "remembered" by MacroMaker. The characters 
are entered into the document when the macro is finished playing. 

To interrupt a macro before it has finished playing, follow these steps: 

1. Click the mouse button. 

The macro stops playing, and MacroMaker presents a dialog box, asking if 
you wish to interrupt or continue playing the macro. 

2. Click Interrupt. 

MacroMaker loses all characters that you've typed since you started 
playing the macro, and it returns you to your application program, with 
only a portion of the script carried out. 

If you click Continue, MacroMaker continues to play the script. 

Checking and changing your macros file 

Once you've set up your macros file, you can check or change it by doing any 
of the following: 

• review your macro list 

• check the script in any macro 

• change the script, name, info, or keystroke in any macro 

• copy or move a macro to another list 

• remove any macro 

--

-

-

-



To review your macro list 

--

- To check a macro 

,.... 

--
-

To change a macro 

-
-
-
-

1. Choose Open MacroMaker from the MacroMaker menu. 

The MacroMaker window appears, showing on the right the list of 
macros associated with the current application program. 

2. To list the same macros by keystroke or info, drag the "View by" 
switch to the right. 

You can also move the switch by clicking in the gray area. 

All macros are listed by name, in alphabetical or numerical order, no matter 
which view you've selected. If a macro has no assigned keystroke or info, 
the listing to the right of that macro's tape icon is blank in the respective 
view. 

To check the script of a macro, follow these steps: 

1. Open a new document in the application program corresponding 
to that list. 

Make sure the application is set to accept menu commands and typed 
characters. 

If you're checking a global macro, you can use any convenient application. 

2. Choose the macro from the MacroMaker menu. 

MacroMaker plays the macro. 

•:• Note: You can also open MacroMaker, select and load the macro, and click 
the Play button. 

You can change any element- script, name, info, or assigned keystroke-of 
any macro by loading it into the cassette recorder. Follow these steps: 

1. If you plan to change the script, first open a new document in the 
application program corresponding to that list. 

If you're changing a global macro, you can use any convenient application. 

2. Choose Open MacroMaker from the Macro.Maker menu. 

The MacroMaker window appears, showing on the right the list of 
macros associated with the current application program. 

If you're changing a global macro, choose Global Macros from the pop-up 
menu of macro lists. The global macro list appears. 
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3. Select the macro you wish to change by clicking its listing in the 
Macro list, and click the Load button. 

As a short cut, you can double-click the macro's listing. 

If necessary, scroll first to bring the macro's listing into view. 

If you've already changed a macro, but it is still in the cassette recorder, 
MacroMaker asks you if you want to store it before loading another. 

When you click Load, the macro is loaded into the cassette recorder. As 
shown in Figure 6-5, the macro's name, info, and keystroke are displayed. 

The macro's listing is dimmed in the macro list. 

0 ' ~ - ~ •. MocroMoker . 

Keystroke for loaded macro -----~­
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Figure 6-5 
A macro loaded in the "cassette recorder" 

4. If you want to change the script, record a new script. 

For details, see "To Record a Macro," earlier in this chapter. 

When you're clone, don't forget to choose Stop Recording from the 
MacroMaker menu. 

5. If you want to change the name, info, or keystroke, type in a new 
one or edit the old one. 

Press Delete (Backspace) if you don't want to assign a keystroke. 

6. Store the changed macro by clicking the Store button. 

The macro is removed from the cassette recorder, and its listing is no 
longer dimmed in the macro list. 

-
-

-

--
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To copy or move a macro 
to another list 

Macros that you've created while working with one application program can 
be used in other applications. Follow these steps to copy or move one or 
more macros to the list associated with another application. 

1. Choose Open MacroMaker from the MacroMaker menu. 

The MacroMaker window appears, showing on the right the list of 
macros associated with the currenr application program. 

2. If you are copying or moving a macro j1·om another list, choose 
the other list from the menu of macro lists. 

The selected macro list appears. 

3. Select the macro you wish to copy or move by clicking its listing 
in the macro list. 

If you wish to copy or move more than one macro, select them by 
holding clown tl1e Command key while clicking the listing for each one. Or 
you can select several adjacent macros by holding down the Shift key 
while clicking the first and the last. 

4. Press Command-C to copy or Command-X to cut. 

Eitl1er command places the selected macros-name, info, script, and 
keystroke-on the Clipboard. Cut removes them from the macro list. 

5. Choose, from the menu of macro lists, the macro list for the 
application to which you want to copy or move macros. 

To convert an application-specific macro into a global macro, choose 
Global macros from the menu of macro lists. 

6. Press Command-V to paste. 

The macros that you earlier copied or cut to the Clipboard are added to the 
currently shown macro list. 

If a macro with the same name or keystroke as a macro you are pasting is 
already in the list, MacroMaker asks if you wish to replace it or cancel the 
Paste command. 

•:• Note: You can also copy a single macro from one macro list to another by 
loading it into the cassette recorder, choosing another list, and clicking 
Store. 
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To remove a macro 
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To remove one or more macros from a macro list, follow these steps: 

1. Choose Open MacroMaker from the MacroMaker menu. 

The MacroMaker window appears, showing on the right the list of 
macros associated with the current application program. 

2. If you want to remove a macro from another list, choose Global 
Macros or the application you want from the menu of macro lists. 

The selected macro list appears. 

3. Select the macro you wish to remove by clicking its listing in the 
macro list. 

If you wish co remove more than one macro, select them by holding 

-

down the Command key while clicking the listing for each one. Or you can -
selecr several adjacem macros by holding down rhe Shift key while 
clicking the first and the last. 

4. Click the Erase button. 

You can also press Command-X to cut. 

The macros are removed from rhe list. 

Working with other macros files 

When you first install MacroMaker, the active macros file is named Macros, 
and ir's located in the System Folder of your current startup disk. However, 
you can create and use other macros files using MacroMaker's Another File 
command. You can switch back and forth between macros files, and you can 
make a copy of any macros file, for use on another Macintosh or just to save 
as a backup. 

-

-
--
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To create or open another 
macros file 

To create or open a new macros file anywhere on your disks, follow these 
steps: 

1. Choose Another File from the MacroMaker menu. 

MacroMaker presents a dialog box, asking whether you want to create a 
new file or open an existing one. (See Figure 6-6). 

lrl ·~-lh~~Pc1l-:I' d-::111\-ljOll-:- --
11.LJ \Witch to cl 1l1ff P1 ent "!'v1dr 1 ll'>" 

I 

tile. All eB1\llnlJ 111tHrus will br.· 
un<w<11ldhlP until 11ou '-ll'llr II 
l1tHk. 

(._cdn~I U Neur 
1 

llpPll 

Figure 6-6 
The Another File dialog box 

-1 

2. Click New to create a new macros file; click Open to open an 
existing macros file. 

A directory dialog box appears. 

3. If you're creating a new macros file, type a name for it. 

It makes sense to use the word Macros in the filename-Abram's Macros, 
for example-so you can easily identify it. 

4. Specify the folder or disk where you want to place your new 
macros file; or select an existing macros file. 

See the Appendix, "Moving Through the File System," or your Macintosh 
System Software User's Guide to learn more about how to use directory 
dialog boxes. 
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To copy or move macros 
to another fde 

To copy or move a 
macros fde 

To rename a macros fde 
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5. Click Save (if you're creating a new file) or Open. 

The dialog box closes. 

When the MacroMaker window is open, the name of the new or just 
opened file appears just above the "View by" switch. You can record, 
change, remove, check, copy, and move macros in that file. 

The MacroMaker menu now calls upon macros from the new or just­
opened ftle. 

If you tum MacroMaker off and on, or if you restart your Macintosh, the 
original macros file is reopened. 

You can copy or move macros to another macros file the same way you copy 
or move macros between macro lists (in the same macros file). Follow these 
steps: 

1. Open a macros file. 

2. Press C.Ommand-C to copy or C.Ommand-X to cut the selected 
macros. 

3. Create or open another macros file. 

4. Use the menu of macro lists to show the macro list where you 
want to place the macros. 

5. Press C.Ommand-V to paste the macros you just copied or cut into 
the macro list. 

You can duplicate any macros file in the Finder by selecting its icon and 
choosing Duplicate from the File menu. 

In the Finder, you can move a macros file just like any other file. However, 
you cannot remove or replace the Macros file in the System Folder while 
Macro.Maker is on. Tum off MacroMaker before removing or replacing the 
file. (See "To Tum Off MacroMaker" in the next section.) 

While working in the Finder you can rename any macros file in the usual 
Macintosh fashion, but you can't rename a macros file while it is active. 

-
-

-
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To turn off MacroMaker 

To turn MacroMaker 
back on 

Turning MacroMaker off and on 

Normally, MacroMaker is turned on. You may wish to turn it off, however, 
so your global macros won't interfere with the use of a specific application 
(one that normally uses, for another action, key combinations that you've 
assigned to global macros). 

1. Choose Open MacroMaker from the MacroMaker menu. 

The MacroMaker window appears. 

2. Drag the On/Off switch, which is on the right, to the Off position. 

You can't record or play macros when MacroMaker is turned off. 

3. Click the close box to close the MacroMaker window. 

The MacroMaker menu is still shown, but all commands except Open 
MacroMaker and About MacroMaker are dimmed. 

1. Choose Open MacroMaker from the MacroMaker menu. 

The MacroMaker window appears. 

2. Drag the On/Off switch, which is on the right, to the On position. 

3. Click the close box if you want to close the MacroMaker window. 
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T E R 7 

Apple File Exchange 

A PPLE FILE EXCHANGE IS A MACINTOSH APPLICATION THAT ALLOWS ~OU TO 

work with documents created on personal computers using MS-DOS and on 

the Apple II using ProDOS®. And it allows anyone with an MS-DOS 

computer or an Apple II using ProDOS to work with documents that you've 

created on your Macintosh computer. MS-DOS stands for Microsoft Disk 

Operating System. It's the operating system that governs the IBM PC 

(under the name PC-DOS) and compatible computers. ProDOS stands for 

Professional Disk Operating System. It's the operating system that today 

controls most Apple II-family computers. 
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An operating system is a program that 
organizes the actions of the parts of the 
computer and its peripheral devices. 

If you've been working with people who use computers controlled by non­
Macintosh operating systems, you know that the world of computing is 
like the biblical Tower of Babel. It is difficult, sometimes impossible, to get 
your computers to work together, because the machines speak different 
"languages." 

With Apple File Exchange (AFE), however, you use your Macintosh to 
translate files so that they make sense when you transfer them between 
computers. 

If your AFE folder contains an appropriate translator file-described in detail 
later in this chapter-you can translate a document created with an 
application program on one operating system into a document that can be 
used with a similar application program on another operating system. For 
example, if you install the right translator file in your AFE folder, you can 
translate an MS-DOS file prepared with WordStar into a MacWrite document. 

By using Apple File Exchange, you and your associates can work together 
more effectively, whether you are building a tower or just trying to run an 
office. 

Start with this chapter to learn the basics of Apple File Exchange-how to 
open the utility and translate files. If situations arise that require using AFE's ,... 
advanced features, this chapter refers you to specific sections of Chapter 8, 
"Apple File Exchange: Advanced Features." Once you're familiar with the ~ 

essential features of AFE, go on to all of Chapter 8. 
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When connected to your Macintosh SE 
or Macintosh II, the Apple PC 5.25-inch 
disk drive exchanges infonnation 
between the Macintosh and 5.25-inch 
disks fonnatted (initialized) with 
MS-DOS. 

Uses for Apple File Exchange 

Apple File Exchange is designed to meet a variety of translation needs. You 
need Apple File Exchange if 

• you have an Apple PC 5.25-inch disk drive and want to transfer documents 
between the Macintosh and an MS-DOS computer that uses 5.25-inch 
disks 

• you are working with an Apple II computer, such as an Apple IIGS®, that 
uses 3.5-inch disks, and you want to transfer documents between the 
Macintosh and the Apple II 

• you are using a telephone line, network, or other connection to transfer 
files between your Macintosh and an MS-DOS or ProDOS computer, and 
you want to translate those files on your Macintosh 

[] D 
[ 1 ~1 111111111=8=1=8=1] l· J 

;or==='>\ [C Jj r===io, 
MS-DOS computer ~ </ Apple Iles 

Apple PC 5.25-inch disk drive ~ 
~~~~~ /1 ' lD\ 

Macintosh with Apple File Exchange 

Figure 7-1 
Exchanging information with both MS-DOS and ProDOS (Apple II) computers 
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What you need 

The Apple File Exchange 
folder 

The file exchange utility runs on any Macintosh computer that has a built-in 
SOOK disk drive. 

If you are planning to use Apple File Exchange to transfer files to or from a 
5.25-inch MS-DOS disk, you'll need either a Macintosh SE or a Macintosh II. 
You'll also need an Apple 5.25 PC Drive and the Macintosh SE-Bus PC Drive 
Card or the Macintosh II PC Drive Card. 

If you're planning to use Apple File Exchange to transfer files between your 
Macintosh and a 3.5-inch ProDOS disk, or if you're planning to translate files 
on your Macintosh, AFE works best when your Macintosh has two or more 
disk drives. Otherwise, you may have to switch disks repeatedly every time 
you translate a file. 

Apple File Exchange appears as a folder on your Utilities disk 2. Before you 
use Apple File Exchange, copy the entire folder to a hard disk or another 
3.5-inch disk with more space available. 

Open the folder, and you'll see the Apple File Exchange application and one 
other ftle, a translator file, labeled DCA-RFT/MacWrite. It contains one or 
more translators, which in turn contain the information that Apple File 
Exchange needs to translate documents. (See Figure 7-2.) 
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Figure 7-2 
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The open APE folder on your Utilities disk 2 
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A text file contains information stored 
in the form of readable characters. 

Files in binary form contain 
information represented as 1 's and O's. 

Obtaining translator files 

DCA-RFf stands for Document Content Architecture/Revisable Form Text. 
Many MS-DOS word processing applications, such as DisplayWrite 3 and 
DisplayWrite 4, allow users to save their documents as DCA-RFf files. This 
translator file contains translators allowing Apple File Exchange to convert 
DCA-RFf files to MacWrite, and vice versa. Apple provides the DCA-
RFf /MacWrite translator file, as well as the equivalent of two built-in 
translator files explained later, but most translators are supplied by otl1er 
companies. 

You'll probably want to add translator files to your AFE folder, so you can 
translate files to or from a variety of MS-DOS or ProDOS applications. For 
example, to convert documents written with WordStar, a popular MS-DOS 
word-processing application, into MacWrite documents or vice versa, you'll 
need a translator file containing translators specifically designed to translate 
Worc!Star and MacWrite files. (See "Obtaining Translator Files" later in this 
section.) 

In addition to the translator files that you see in the AFE folder, the Apple 
File Exchange application itself contains the equivalent of two translator 
files: 

• The "Text translation" file contains translators for exchanging text files 
with both MS-DOS and ProDOS computers. 

• The "Default translation" file contains translators for copying any file, in 
binary form, to and from both MS-DOS and ProDOS computers. 

You should be able to buy a variety of Apple File Exchange translator files 
from your auiliorized Apple dealer or representative, as well as from many 
other suppliers of computer software. The translators for WordStar and 
MultiMate, used as examples in mis guide, are products of Dataviz, Inc., 
14 Winfield Street, Norwalk, Connecticut 06855, USA. 
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Three possible scenarios Apple File Exchange is a flexible tool. It can help you select the files or 
translators for each translation, or it lets you make the choices yourself. AFE 
is designed to translate files in any of the three following situations: 

• You know which files you want to translate, and you want Apple File 
Exchange to select the translators. This is the simplest way to use AFE, 
and it is described in this chapter. 

-
--

• You know which files you want to translate, but you want to select the -
translators. You need to know a little bit more about Apple File Exchange. 
When you get to the section "Making Sure the Translators You Need Are 
Active," in this chapter, read the section "Selecting Translators" in 
Chapter 8, too. 

• You know which translators you want to use, but you don't know which 
files you want to translate. Once you've mastered the essential steps of 
translation, as described in this chapter, you can learn how to take this -
approach by reading "Letting AFE Help Select the Source Files" in 
Chapters. ~ 

Using Apple File Exchange 

No matter how many files you plan to translate, or how many translators 
you expect to use, you follow seven basic procedures: 

1. To get started, you first open the Apple File Exchange application. 

2 Next, you show the disk containing the files you want to translate and 
the disk you want to receive translated files. 

3. You tell AFE where to put translated files. 

4. Next, you select the files you want to translate. 

5. You make sure that the translator(s) you need are active in the 
appropriate translation menu. 

6. Then you translate your files, making sure that the translated files will fit 
on your destination disk. 

7. Finally, you finish up by closing Apple File Exchange and working with the 
translated files. 

Each of these procedures is described step-by-step in the following sections. 

-

-
----
-
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Getting started To open Apple File Exchange, follow these steps: 

1. Open the AFE folder by selecting its icon and choosing Open from 
the File menu, or by double-clicking the AFE folder icon. 

2. If you have obtained other translator files, copy them into the 
AFE folder. 

Some suppliers may package several 1.ranslator files together. Follow their 
instructions for placing the files in the folder. 

3. Open the Apple File Exchange application by selecting its icon 
and choosing Open from the File menu, or by double-clicking the 
icon. 

The Apple File Exchange window appears. The directory list on the left 
shows files and folders on the disk containing Apple File Exchange. 

The AFE window resembles the Font/DA Mover dialog box. In fact, you 
can select files in Apple File Exchange essentially the same way you do in 
Font/DA Mover. 

Figure 7-3 illustrates a typical AFE window showing an MS-DOS disk and a 
Macintosh disk. 
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Showing your disks 

A source disk is a disk containing files 
you want to translate. A destination 
disk is a disk that you select to receive 
translated files. 

You use the AFE window to select the files you want to translate and to 
specify the folder you want to receive translated files. You begin by showing 
both your source disk and your destination disk. 

1. Click the right-side Drive button and, if necessary, insert your 
source disk until the source disk is shown on the right side of the 
AFEwindow. 

If you show a Macintosh disk on the right side while a Macintosh 
disk-either the same one, or another-is shown on the left side, Apple 
File Exchange presents a translation menu, "Mac to Mac," on the menu 
bar. 

Once you are working in Apple File Exchange, your Macintosh accepts 
3.5-inch ProDOS disks that it would normally eject with an error message 
such as "This is not a Macintosh disk." 

When you insert a 5.25-inch MS-DOS disk into your Apple 5.25 PC Drive, 
push down the lever at the front of the drive. 

Click the right-side Eject button if you need to eject a 3.5-inch disk, or 
remove a 5.25-inch disk manually after lifting the lever on the front of the 
disk drive. When you eject or remove a disk, its directory list appears 
dimmed until you reinsert it, insert another disk, or click Drive. 

•:• Note: You can, if you prefer, show the source disk on the left side of 
the AFE window. In that case, be sure to show the destination disk on 
the right side. This method makes sense, for example, if the disk 
containing your AFE folder is also the source disk, because that disk is 
automatically shown on the left when you open Apple File Exchange. 

2. Click the left-side Drive button (and, if necessary, insert your 
destination disk) until the correct destination disk is shown on 
the left. 

If the destination disk is already shown, you can skip this step. 

Insert and eject disks as described in step 1. 

Apple File Exchange displays, beneath the disk name, the space available on 
the disk. 

90 Chapter 7: Apple File Exchange 

----
-
-
--
--

-
..... 

-----
---



-
-----
..... 

--
-------
-
...... 

-

Whenever you show an MS-DOS or ProDOS disk in the AFE window, Apple 
File Exchange presents two translation menus listing translators associated 
with the two operating systems shown. For example, when the disk shown 
on the left is a Macintosh disk and the disk shown on the right is MS-DOS, 
Apple File Exchange shows menus for "Mac to MS-DOS" and "MS-DOS to 
Mac." 

•!• Note: Apple File Exchange is capable of translating files between the two 
non-Macintosh operating systems. Thus, it is possible to show menus for 
"MS-DOS to ProDOS" and "ProDOS to MS-DOS." (See "Tran.slating files 
between MS-DOS and ProDOS" in Chapter 8.) 

An icon to the left of each file tells you what it is. (See Figure 7-4.) 

•!• Note: If a small lock icon appears next to the directory list of a 3.5-inch or 
5.25-inch disk, the disk is locked (write-protected). AFE will not work 
with a locked destination disk, so unlock the disk before you translate 
files. To unlock a 3.5-inch disk, eject it and slide the locking tab away from 
its edge. To unlock a 5.25-inch disk, remove the disk from the drive and 
remove its locking tab. Then reinsert the disk. 

Folder 

~ 
~ 

Application 

Text document 

Figure 7-4 
Icons identifying ftles and folders 

D 
Document 

System file 
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Specifying where to put 
translated files 

Now you're ready to specify where AFE should put the translated file(s), or 
destination ftle(s). If you plan to place the destination files in the disk­
level directory- that is, not in a folder- you can skip to the next section. 

If you want a folder to receive the translated files, you specify that folder as 
the directory title, just above the destination disk's directory list. As shown 
in Figure 7-5, the directory title and disk name are initially the same. You can 
specify an existing folder or create a new folder. 

•!• Note: Apple File Exchange treats MS-DOS "directories" and ProDOS 
"subdirectories" as folders, but it does not recognize folders on 400K 
Macintosh disks. In that case, all files are simply listed in the directory list 
for the disk. 

To specify an existing folder 

You can specify an existing folder by moving through your file hierarchy. See 
the Appendix, "Moving Through the File System," or your Macintosh System 
Software User's Guide for details. 
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Selecting the files you 
want to translate 

To create a new destination folder 

Follow these three steps to create a new folder as the destination for your 
translated files: 

1. Click the New Folder button below the directory. 

Apple File Exchange presents a dialog box like that in Figure 7-6. 

Plea~e gille the new folder 
a name: 

Camel I OK 

Figure 7-6 
The dialog box for naming a new folder 

2. Type a name for the new folder. 

Apple File Exchange rejects folder names that are too long or that contain 
characters or sequences not acceptable in the destination disk's operating 
system. 

Use the mouse and keyboard to edit the folder name. 

3. ClickOK. 

Next you need to specify which ftle(s) you want to translate by displaying 
and selecting them in the APE window's right-side directory list. You can 
select these files individually by their ftlenames, or you can select all the ftles 
in a folder by selecting the folder's name. 

1. Display the directory list containing the files you want to 
translate. 

A directory list contains the names of files or folders contained in the disk 
or folder shown as the directory title. 

If the files you wish to translate are not shown in the disk directory 
because they are nested in folders, then open folders until the files are 
shown in the directory list. 
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A source file is any file that you select to 
be translated, copied, or removed. 

The folder Leners represents an 
MS-DOS "directory" 

2. Select the file(s) or folder(s) you want to translate by clicking 
its name in the directory list 

Whenever you select one or more source files, Apple File Exchange 
displays, in the center of the AFE window, the total disk space selected. 
If you're selecting a large number of files, it may take Apple File Exchange 
several seconds to complete this calculation. 
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= HardU1sk liJ PUBS 
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Figure 7-7 
The file NEWSJAN.RFf is selected 
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You can select as many files or folders as you want. Use the first method 
that follows to select any collection of files and folders. Use the second 
to select adjacent files and folders. 

• Method 1: Hold down the Command key and click the files or 
folders you wish to select. 

All files or folders that you click remain selected. 

• Method 2: Hold down the Shift key and click the first and last 
files or folders. 

Those two files or folders, and all of those between them in the 
window, are selected. 
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Making sure the translators 
you want are active 

•!• Note: If you've selected the entire contents of a disk or folder, there are 
three simple ways to remove the selection: 

• You can select a file in the other directory- if one is shown-in the 
AFE window. All files in the first directory are deselected. 

• You can type any keyboard character except Return. All files except one 
are deselected. 

• You can deselect a single item by clicking it while holding down the 
Command key. 

Apple File Exchange finds and uses the appropriate translators to translate 
the files you've selected, as long as the translators are in the appropriate 
translation menu and are active. 

1. Open the translation menu you need by pointing to its title in the 
menu bar and holding down the mouse button. 

Each translation menu lists the applicable translators from your Apple File 
Exchange application and folder. For example, the "MS-DOS to Mac" menu 
shows all the translators in your AFE folder that translate MS-DOS files to 
Macintosh documents. If you want to translate Macintosh documents 
into MS-DOS files, open the "Mac to MS-DOS menu," instead. 

If you haven't added translator ftles to the AFE folder, the "MS-DOS to 
Mac" menu lists "DCA-RFT to MacWrite," "Text translation," and 
"Default translation." 

Most translator files contain translators for taking a translation in both 
directions. That is, the DCA-RFT/MacWrite translator file contains a 
translator for "DCA-RFT to MacWrite" and one for "MacWrite to DCA­
RFT." 

One menu item, "Other translations," is not actually a translator, but a 
command that you use to call upon translators not shown in the menu. 
See "Translating Files on Your Macintosh Disk" in Chapter 8. 
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If you've copied into the AFE folder other translator files capable of 
converting files created with MS-DOS applications programs into 
Macintosh documents, they are listed alphabetically, along with "DCA­
Rff to Mac\Vrite," above the dotted line. 

The Text and Default translations always appear below the dotted line. 
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{l//Jp; lill//J/{tl!tHlJ ... 

As shipped With additional translators 

Figure 7-8 
Two versions of the "MS-DOS to Mac" menu 

2. Make sure that the translators you need are active; if not, select 
them. 

Translators are active-that is, Apple File Exchange can call upon them to 
translate files-when they are preceded with a check mark or, in the case 
of the "Default translation," which is always active, a diamond. See 
"Selecting Translators" in Chapter 8 to learn how to activate and 
deactivate translators. 

Any translator name that is followed by ellipsis points ( ... ) is governed by an 
options dialog box. For more information, see "Sening Options" in Chapter 8. 
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Now you are almost ready to translate your files. First, however, you should 
make sure the translated files will fit on the destination disk. 

1. Compare the space selected, as shown in the center of the AFE 
window, with the space available in the destination disk. 

The space selected actually gives you only a rough idea of the space that 
the translated files will take up, since translations frequently alter the 
length of files. 

2. If there is not enough space, you can do any of the following: 

• deselect some of your source files 

• use another destination disk 

• select unneeded files on the destination disk and click Remove to 
delete them 

3. When the space available is sufficient, click the Translate button. 

If Apple File Exchange finds two or more active translators-other than 
Text or Default-capable of translating any source file, it presents an alert 
box like the one shown in Figure 7-9. 

In addition, some translators, from suppliers other than Apple, might not 
properly distinguish between applications. If two or more translators try 
to translate a file, even if they are listed with distinct source applications, 
Apple File Exchange opens the aleit box. 

More thtrn one t101t\l<1tnr con hilndlt• the frle 
Oi>r emhPr '<ell" whu h 1\ 111 ttie folder 
1'PU1\leltP1\ • Pleil\P \Pleet the one 110111111\h 
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Figure 7-9 
The alert box for conflicting translators 
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If the alert box appears, select the translator you want and click Continue. 
To learn other ways you can select translators, see "Selecting Translators" 
in Chapter 8. 

If the names of destination files or folders conflict with existing files or 
folders, or with each other, Apple File Exchange warns you and allows you 
to change the destination names. (See "Resolving Filename Conflicts" in 
Chapters.) 

When there are no conflicting translators or filenames, Apple File Exchange 
translates the selected files. As each file is translated, the progress window 
shows the source filename, its destination filename, and the translator. For 
each file, the horizontal bar reports what percentage of the current 
translation is complete. Entries at the bottom of the window tell how many 
files you selected and how many files have been translated. The progress 
window is shown in Figure 7-10. 

---- ---------~~ 

( opyrng f1IP: To f1IP: 

Nf lll~JAN.RrT l'-.EUl~.JAN.Rf r 

Translation: OCA-nFT to Maclllnte i. Cane 1>1 _! 

p;zs. +-------f-- --r-====i 
0 :: 50' 75' 1 oo·~ 

~--folders to be c op1ed: I 

Figure 7-10 
The progress window 

The progress window closes shortly after Apple File Exchange is finished 
translating files. 

If you click Cancel or type Command-period, translation is halted. Files that 
have already been translated remain in the destination folder or disk. 
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Once you have compleced a cranslation, you can start setting up anocher one, 
or you can quit Apple File Exchange. 

• Choose Quit from the File menu window to return to the Finder. 

Whenever you quic Apple File Exchange, 5.25-inch MS-DOS disks are no 
longer recognized by your Macintosh- for example, they are not shown 
on your desktop-and 3.5-inch ProDOS disks are ejected automatically. 

What translators do 

Once you have translated your files, it makes sense to open them---0n che 
appropriate computer-to see what they now look like. If you have the right 
computer, you should be able to work with any translated file, but the 
accuracy and completeness of translation varies, depending upon three 
factors: 

• the differing structures of the source and destination operating systems 

• the similarities and differences between the source and destination 
applications 

• the quality of the translator software 

The translation between DCA-RFT and MacWrite, described in detail in 
Chapter 8, illustrates both the benefits and limitations of translation, even 
when the translator program is well written. In eicher direction, the 
translators preserve text and essential format inscructions, such as paragraph 
breaks. 

However, because MS-DOS computers do not offer the range of type fonts, 
sizes, and styles available on the Macincosh, chat information is lost in 
translations from MacWrice to DCA-RFT. Similarly, because MacWrite does 
not have a footnote feature, DCA-RFT footnotes cannot be shown as 
footnotes in translations to MacWrite. Such changes, however, are noted in 
che AFE User Log, described in Chapter 8. 
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Frequently, you can quickly restore documents to their original shape after 
translation. For example, although the "DCA-RIT to MacWrite" translator r 
does not preserve the centering of text, you can use rulers or the Align Center 
command (Command-M) from the MacWrite Format menu to center ri 
sections or lines of text. 

As you familiarize yourself with the Apple file exchange utility, the 
translators you've obtained, and the applications you're using, you'll find 
that nearly all the information you need is translated intact from computer 
to computer. And you can fine-tune afterwards whatever differences appear 
as a result of translation. 

•:• Note: You can learn about the features of specific translators either from 
printed guides that accompany translator files or from the About Apple 
File Exchange window, which is described in "Selecting Translators" in 
Chapter 8. 
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Apple File Exchange: 
Advanced Features 

N THIS CHAPTER YOU LEARN HOW TO USE SOME OF THE APPLE FILE EXCHANGE 

application's more complex features, including 

• how to select the translators you want to use 

• how to let Apple File Exchange (AFE) select the source files when you've 

selected the translators 

• translating MS-DOS and ProDOS files that you've already copied onto a 

Macintosh disk 

• resolving filename conflicts 

• using the AFE User Log to keep track of your activity 

• sening the options for specific translators 

• how to save translator selections and options senings for future use 

You also learn some specifics about the "DCA-RFf to MacWrite" and 

"MacWrite to DCA-RFf" translators introduced in Chapter 7. 
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To select translators 

Selecting translators 

In Chapter 7 you learned how to set up the AFE window so that the Apple r"I 
file exchange utility would use the translator appropriate for each source file 
that you select. Apple File Exchange asked you to decide among translators r 
only if two or more translators were capable of translating any given file. 
When using this method, all translators must be active-that is, preceded by 
a check mark or, in the case of the default translation, a diamond. 

At times, however, you may want to select the translators yourself. Perhaps 
you're tired of seeing the alert box that warns you of conflicting translators. i'1 
Or maybe you want to select a translator so that Apple File Exchange can 
select the source files, as explained in the next section. -

Make sure that the translators you want are active and that the ones you 
don't want are inactive. 

• To activate an inactive translator (one without a check mark), 
drag down the translation menu and release the mouse button 
when the pointer is on the name of the translator. 

The check mark is added. 

When you activate a translator that is followed by ellipsis points (. .. ), the 
Apple file exchange utility presents an options dialog box. See "Setting 
Options" later in this chapter. 

• To deactivate an active translator, drag down one of the 
translation menus and release the mouse button when the pointer 
is on the name of the translator. 

The check mark is removed. 

Once you activate or deactivate translators, those setting are retained, even if 
you change menus, until you change the settings or quit Apple File Exchange. 
To save the settings for future use, see "Sa\·ing and Restoring Settings" later 
in this chapter. 

-
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Menus displayed in 
windows 

How Apple File Exchange 
uses translators 

If you plan to activate or deactivate several translators at once, you can save 
time by turning any translation menu into a window. Simply drag down past 
the bottom of the menu. A window containing the menu appears when you 
release the mouse button. You can drag the window by its title bar. 
Activating another window may hide it, but you can make it reappear by 
dragging down past the menu again. You close the menu by clicking its close 
box or by selecting a disk from a different operating system, which results in 
a different set of menus. 

When a menu is shown in a window, you can click any translator to activate 
or deactivate it. You can show one or two menus at a time by turning them 
into windows. 

'-1\ 00\ to "1·H 
.,... oc A nn to "1ac Ulr 1tP 
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Figure 8-1 
A menu in a window 

The next time you translate files, the file exchange utility looks at the active 
translators above the dotted line in the appropriate menu. (The appropriate 
menu is the one that shows the source disk's operating system and then the 
destination disk's operating system.) 

If none of the active translators above the dotted line can translate a source 
file, Apple File Exchange considers a text translation if the "Text translation" 
translator is active. 

• With Macintosh and ProDOS source files, Apple File Exchange selects 
"Text translation" only if a document has been saved as a text file-that 
is, "text only" on the Macintosh or "TXT" on the Apple II. 

• With MS-DOS files, Apple File Exchange selects the text translator if most 
of the characters in a source file are readable keyboard characters. 

Selecting translators 103 



To learn about translators 

If no other translator is capable of transferring a file from one operating 
system to another, Apple File Exchange uses the default translation to make 
a copy in binary code. If you use the default translation to copy an MS-DOS 
or ProDOS file to your Macintosh disk, you may later be able to obtain 
translators to convert the file into a useful document. (See "Translating Files 
on Your Macintosh Disk" later in this chapter.) 

•!• Note: The Apple file exchange utility shows and uses only those 
translators that are contained in translator files shown in the AFE folder. 
Thus, you can remove translators from the translation menus by 
dragging their respective translator files out of the AFE folder. 

You can also hide translators by using the Finder to create a new 
folder-call it something like Extra Translators-within the AFE folder 
and then dragging into it translator files you don't need now. 

These methods, however, remove translators going in both directions, 
such as "MacWrite to DCA-RFT" and "DCA-RFT to MacWrite." Working in 
the menus, however, you can leave one translator inactive while the 
converse is active. 

Many translators contain brief descriptions of their functions. To view those 
descriptions, fo llow these simple steps: 

1. Choose About Apple File Exchange from the Apple menu (or 
press Command-A). 

The About Apple File Exchange window, containing a list of translators, 
appears. See Figure 8-2. 
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A file is eligible if it can be translated 
with a selected translator. 

2. Select any translator, and then click the About button to display 
a description of that translator . 

3. Click the Done button or press Return to close the About Apple 
File Exchange window. 

Letting AFE help select the source files 

At times, you may know which translator(s) you plan to select, but not 
know which files are eligible for that translation. For example, you may 
wish to convert all WordStar files on your MS-DOS disk into MacWrite 
documents, but you don't have the time to figure out which of your 
MS-DOS files were written with WordStar. 

Apple File Exchange is designed to figure it out for you. Follow these steps 
to select eligible source files. 

1. Show the source and destination disks in the AFE window. 

See "Showing Your Disks" in Chapter 7. 

2. Unless you plan to translate files into the destination disk's disk· 
level directory, specify the destination folder in the AFE 
window. 

See "Specifying Where to Put Translated Files" in Chapter 7. 

3. Select the desired translator(s) in the appropriate translation 
menu. 

See the previous section, "Selecting Translators." The appropriate menu is 
the one with the operating system from which you want to copy shown 
first. 
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4. Choose Show Only Eligible Files from the File menu or press 
Command-E. 

The command is checked until you choose it (or press Command-E) again. 

In both directory lists, Apple File Exchange dims the names of files that 
cannot be translated with the selected translator(s). Because the folders 
shown in the directory lists might contain eligible files, they are not 
dimmed. 

To have Apple File Exchange search the folders shown in the directory 
lists (and folders nested in those folders) for eligible files, hold down the 
Option key while choosing Show Eligible Files. Apple File Exchange dims 
those folders that do not contain eligible files. If your folders contain a 
large number of files, this can be a time-consuming process. 

When you select a folder that isn't dimmed and then click Translate, all 
eligible files contained in that folder (and nested folders) are translated. 
This is true as long as the Show Eligible Files feature is turned on 
(checked), whether or not you held down the Option key while choosing 
the Show Eligible Files command. 

-----------
1 ~ file Edit MM to MS-OOS MS--OOS to Ma( 

Apple File [H( hdnge 

m. I! I~.=:.: Newsletter;] 
l -

I iiJ PUHSI 

I ~ December News rir1 ID BITSDEC.RFT -,Ji< 
! December News Reus. --~ --------.

1 

D BITSJAN.RFT t· 

I NEWSJRN.RFT - --- __ ) ' .. i COY.MflN!Ll OM 
I Nouember News Ir . . ~ D LETTERS I< 
I ~~:~~~~~~re~~, tn~ : '----- ---- - I g ~~~~~~~:~~~ 
1

1

/

11 

... Odnh:Dt<•s .. Jj !_ _J · 
l __ . Har ltDISk ~ PUBS 

11 I J '\llJ.'1K hqtr<> <Hldllable 1 ZOK Llytes .wi.lilable _.• 

11 INe1~• fnl1~~ ~'""=i iN~:~ ~~ I 
i. 

Figure 8-3 
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5. In the source disk directory list, select all files and folders that 
are not dimmed. 

When you select folders that contain both eligible and ineligible files, 
Apple File Exchange will translate only the eligible files, as long as the 
Show Only Eligible Files command is checked. 

•:• Note: The Show Only Eligible Files command does not show as eligible 
those files that can be translated only with the text or default 
translations. Use this procedure, therefore, if you don't want any text 
or default translations. 

6. Continue by clicking the Translate button. 

See "Translating Files" in Chapter 7 for a description of the rest of the 
translation process. 

Translating files on your Macintosh disk 

Thus far, you've learned how to use the Apple file exchange utility to 
exchange files between your Macintosh and MS-DOS or ProDOS disks. 

You can also use Apple File Exchange to translate MS-DOS and ProDOS files 
that are already on one of your Macintosh disks, but which cannot be "read" 
by Macintosh applications---except Apple File Exchange. You may have 
obtained those untranslated files in many ways: through a telephone line, 
over a network, or even by using Apple File Exchange's default (binary) 
translator. 

And you can use Apple File Exchange to create MS-DOS and ProDOS files on 
your Macintosh disk, so you can send them to an Apple II or an MS-DOS 
computer. 

This feature is particularly valuable if you have a disk, such as a 5.25-inch 
ProDOS disk, that cannot be used by your Macintosh, but you can transfer 
files in some other way-such as over a telephone line. 
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Between applications You can use application-specific translators to translate to or from MS-DOS 
or ProDOS files stored on your Macintosh disk. Follow these steps: 

1. Select the destination folder or disk and the source files in the 
AFEwindow. 

Since both the source and destination disks are Macintosh disks, the "Mac 
to Mac" menu appears. 

2. Choose "Other translations" in the "Mac to Mac" menu. 

A dialog box appears. 

\elt•t t t110\ e tran~l<1lron' wh1rh uo1ll 1>e rldCIPcl to or 1 
r emoLJed fr om the "Mar to Muc m enu. 

"ti 
I 

Figure 8-4 
A typical "Other translations" dialog box 

3. Make sure the Add button is selected. 

•. • Add 

Rernot•e 

~~ 

~:- :~ 

A scrollable list, listing translators by translation menu, is displayed. 

You can select and add to the "Mac to Mac" menu any translator that is 
not dimmed. Any translator that you've already added to a menu is 
dimmed in the list of translators for the menu to which you've added it. 
However, you can still select that translator in the list for the menu 
where it normally appears. 
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4. Click to select the translators you want to add to the "Mac to 
Mac" menu, and click OK. 

Hold down the Shift key or Command key to select more than one 
translator. 

The next time you use the "Mac to Mac" menu, the translators you 
selected appear just above "Text translation." 

If you save your settings, the added translators are shown in the menu 
whenever you restore those settings. (See "Saving and Restoring Settings" 
later in this chapter.) 

•:• Note: You can use the same procedure to add translators to any 
translation menu. 

l#rtl"Mtl 
./Mult1m.ite to Mdr lll11tP 

./lllo1 d~ta1 to Mdll1111te 

./M.ic l1111ll' to Mult 1111 <1IP 

./McH lll1 ill' IO lllOI cJ~lcH 

TPH I II clllSlclllOO ... 

•Ot>fdUlt II clO\l<l t1 on ... 
• ..- ·,·· (·· c· .• ':1( , ;.,•,_, 

Figure 8-5 
The "Mac to Mac" menu with added translators 

s. Make sure the translators that you want to use are active. 

6. Click the Translate button. 

See "Translating Files" in Chapter 7 for a description of the remainder of 
the translation process. 

•:• Note: To remove an added translator from a translation menu, choose 
"Other translations" in that menu and make sure that the Remove button 
is selected in the dialog box that appears. You can remove any translator 
that is not dimmed-that is, any added translator listed under the name 
of the menu to which you've added it. However, translators are now 
dimmed in the list for the menu where they nonnally appear; this means 
they can't be removed from that menu. Click to select the translator that 
you want to remove, and click OK. Hold down the Shift key or Command 
key while clicking other translators if you want to remove more than one 
translator. 
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As text 

110 

The "Mac to Mac" menu always contains a text translator, which you can use 
to translate Macintosh text files to or from MS-DOS or ProDOS text files 
stored on your Macintosh disk. Use it to clear up differences in the way the 
different operating systems format text. Unless you reset its options, 
however, Apple File Exchange uses this translator to make a straight 
Macintosh copy. (See "Setting Options" later in this chapter.) 

To reset the options, follow these steps: 

1. Open the "Mac to Mac" text translation options dialog box. 

l hooH· 1111• for llldl rn the tint tom r 1gtll 
r o r rw r 111 111 r h m o '> t c I o s e I y rn a t r h e '> y o u t 
neeth. Tilt> optrons for lh<11 for mat wrll 
then lle t1rsplayrd. 

If you ctioo<>e the format ·strarght [OJllJ' 

I a s lJ o u c a n s e r. I his 1 s t he o n e s e I ec I P rl 
rrght now I. then no chdnges will be rnacle 
to qout teut file when It 1s transl<ilecJ. 

OK 

Figure 8-6 
The "Mac to Macn text translation options dialog box 

-~ 

U1Q_ose formQl; 

•.0• Strnrght ( OJlY 

:· !Vlac lo ProOOS 

, • ProDOS to Mac 

1'1dc to "1S-OOS 

• -, MS-OOS to Mac 

·:·MS-DOS to Prnnos I 
ProlJOS to MS-UOS 

2 Select the text translation corresponding to your source and 
destination operating systems. 

The options dialog box associated with that translation appears. 

For example, if you want to send a translated Macintosh text file to an 
MS-DOS computer as an MS-DOS text file, select "Mac to MS-DOS." 
Among other features, this lets you add a line feed to each carriage return 
so it's interpreted correctly. 

3. Reset the options, if necessary. 

4. Click OK. 
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Translating files between MS-DOS and 
Pro DOS 

You can use the Apple file exchange uliliry to translate MS-DOS files into 
ProDOS files, and vice versa. In this case, your Macintosh serves as a bridge 
linking the two other operating system. 

• If you want lo use application-specific translators, in most cases you'll 
need to translate from the source operating system to a Macintosh file, 
and then translate again from the Macintosh file to the destination 
operating system. You are unlikely to find translator files containing 
"MS-DOS to ProDOS" or "ProDOS to MS-DOS" translators. 

• If you want to make a text translation or a binary copy, show one non­
Macintosh disk as your source disk and one from the other non­
Macintosh operating system as your destination disk. The "MS-DOS to 
ProDOS" and "ProDOS to MS-DOS" menus, containing both text and 
default translations, appear automatically. 

• If you need to, you can choose "Other translations," from either the 
"MS-DOS to ProDOS" or "ProDOS to MS-DOS" menu, to add translators 
to those menus. 

Resolving filename conflicts 

In using Apple File Exchange, you may run into one of the three following 
situations in which destination filenames conflict with other file and folder 
names. In each situation, you see an alert box after you click Translate. 

• A destination file has the :,ame name as an existing folder (or a destination 
folder has the same name as an existing file) in the destination directory. 

An alert box allows you to click the Rename button to display a window 
in which you can create a new name for the destination file or folder. You 
can also click Cancel to cancel the translation. 
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• Two destination filenames or folder names are the same. This can happen 
if you are converting Macintosh files to MS-DOS or ProDOS. Those file 
systems do not allow filenames as long as those allowed on the 
Macintosh, and they do not recognize characters allowed in Macintosh 
filenames. Consequently, sometimes the Macintosh filenames are 
truncated or altered, turning similar source filenames into duplicate 
destination filenames. 

An alert box allows you to click the Rename button to display a window 
in which you can create a new name for the destination file or folder. You 
can also click Cancel to cancel the translation. 

• A destination file has the same name as an existing file (or a destination 
folder has the same name as an existing folder) in the destination 
directory. 

An alert box allows you to click the Rename button to display a window 
in which you can create a new name for the destination file or folder. You 
can also replace the existing file (or folder) with the new translated file, or 
you can click Cancel to cancel the translation. 

When you need to rename a file, click Rename in whichever alert box Apple 
File Exchange presents. The Rename window appears. (See Figure 8-7.) 

·:• Note: If you anticipate conflicts, or want to change filenames for any 
other reason, you also can activate the Rename window before clicking 
Translate by choosing Rename Destination Files from the File menu. 

The Rename window lists the source files and folders that you selected in 
the window. You can scroll the list, open folders, and move toward the disk 
directory using the techniques described in your Macintosh owner's guide. 

For each file or folder, there is space for a symbol identifying a naming conflict. 
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Figure 8-7 
A typical Rename window 

To the right of each source file or folder name, the corresponding destination 
file and folder names are displayed. The source and destination names are 
scrolled together. 

When you first activate the Rename window, the destination name is the 
same as the source name or a slightly altered or truncated version. To change 
destination names, follow these steps: 

l. Select any destination filename. 

You can select the next destination filename on the list by pressing the 
Tab key, and you can select the previous listing by holding down the 
Command key while pressing the Tab key. 

2. You can edit the selected destinaticn filename by using the mouse 
and keyboard in the standard Macintosh fashion. 

3. Click Translate to confirm. your changes. 

This closes the Rename window and restarts (or starts) the translation 
process, using the new destination filenames. 

If you click Cancel, AFE changes no filenames and translates no files. The 
Rename window closes, and you return to the AFE window. 
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Keeping track of your activity 

Whenever you copy or remove a file, the Apple file exchange utility adds 
listings to the end of the User Log. The User Log shows the following 
information: 

• The time and date translation (or deletion) begins and ends. 

• The menu used for translation. 

• The source and destination name of each file and folder. Source files (or 
folders) within folders are indented. 

• The translation used for each item. 

• Error messages. 

• Other messages specified by the translator. For example, the entries for a 
translation from MacWrite may list fonts and character styles that 
couldn't be carried over into MS-DOS or ProDOS files. 

~ ~~===-·~lher Loq -

I '-·:r•JmJ!t1 '· r1 [ o ~. -+ _ 1 7 ·- u· .. ·· .; Fr 1 

r. t--· ri.. - r.c fl•;:£;; F'FT : 1 ~. ·, 1t •. t ( - .. H" 

I 
r_1 . .. rr.t ... 1 F-t .. ;,- - _ ~:1_1' U \E:EF' F~I) :C···f;•Jlt It ,_r,~l1t1 r. 
.i 1 .. t ... , r·•· - 1'·11."En·u Prr ,r h \.,., 1t .. '·· l·• ...... -fr: 
C • t .. , '°t t ; -- :T E:U·F H - (···~HI''" ,r_ 1Jt 

1. ~11r-: 1-m1 t .. j -J .. 1 : .' _ 111 .11 Fl I 

,: .. .. !' 

Int / JArJf=rT - rn.·:,· 

·~· ~ t '' 1, n1 t.-.J ·l .. 1 _ -:c r.-- Pt' 

Figure 8-8 
Sample entries in the User Log 
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Choose Show User Log from the File menu to show the User Log. (The File 
menu is shown in Figure 8-9.) Once the User Log is shown, you can choose 
commands (from the File menu) to save the log as a Macintosh text-only 
document, print the log, or clear it. Choose Page Setup to format the User 
Log for printing. When you choose Save User Log As, Apple File Exchange 
presents a dialog box allowing you to name the User Log and to designate 
the disk and folder where it it will be saved. Click the User Log window's 
close box to hide it once you've saved it or have finished looking at it. 

The User Log is cleared whenever you quit Apple File Exchange. 

I Show User Log 

I 

(led! User Log 

Restore settings trom ... 
\ewe settings as ... 

Paqe Setup ... 

Rename Oes tinat1on Files ... 
Show OnhJ Eligible Files ::it:[ 

Erase 01sl< ... 

Quit 

Figure 8-9 
The File menu in Apple File Exchange 
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Setting options 

Whenever you activate a translator that is followed by ellipsis points (. .. ) in 
one of the translation menus, Apple File Exchange presents an options dialog 
box for that translator. You can also show an options dialog box for a ,_, 
translator that is already active by clicking the name of the translator while 
holding down the Option key. i""i 

The authors of each translator have preset the options in what they consider 
useful settings, but you can change them. Apple File Exchange saves the new 
settings until you change them again or quit AFE. 

As described later in this chapter, you can save the settings in a special 
settings file. Then you can restore them at any time, even after quitting and 
reopening Apple File Exchange. 

Each of the text translators has its own options dialog box, allowing you to 
make minor changes in the translation. The "Mac to Mac" text translation 
options dialog box, shown earlier in Figure 8-6, lets you activate the options 
dialog box associated with any of the other text translations. 

Each of the other text translation dialog boxes raises two or three of the four 
following issues: 

• Carriage return and line feed. MS-DOS computers generally use two 
characters, a carriage return (return character) and a line feed, to end a 
line, but the Macintosh and Apple II use just a carriage return. All text 
translators are preset to establish this correspondence. 

• Special characters. Certain Macintosh characters, which you can type while 
holding down the Option key, are not normally shown on MS-DOS or 
ProDOS computers. Similarly, certain MS-DOS characters are not used in 
the other two operating systems. 

When using a text translator to translate Macintosh documents or 
MS-DOS files, Apple File Exchange automatically selects the Neither 
button. Use this setting if you don't want to lose the special characters 
when you retranslate a document back into its original operating system. 

Select "Change to closest single character" to have AFE substitute the 
character that is the closest equivalent of the special character- such as 
'Y' for '¥'. 

Select "Change to multiple characters" if you want to break up accented 
characters into the closest equivalent character and the accompanying 
accent. 
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On the Apple II and MS-DOS 
computers, a control character is a 
nonprinting character that controls or 
modifies the way information is printed 
or displayed. 

• Control characters. The Macintosh does not generally recognize control 
characters. 

When using a text translator to translate a ProDOS file, Apple File 
Exchange automatically selects the Neither button. Use this setting if 
you don't want to lose the control characters when you retranslate a 
document back into a ProDOS file. When you open the translated 
document on your Macintosh, each character will probably be represented 
by a rectangular outline. 

Select "Remove unnecessary control characters" to remove them from the 
translated files. 

Select "Make control characters visible" to show them in the translated 
files. They will be preceded by an upward-pointing arrow. 

• Tab characters. Since translation does not necessarily preserve the 
horizontal spacing of text, all of AFE's text translators allow you to reset 
tab stops and have the translator replace multiple spaces with a tab 
character in the translated file. Select "Neither" if you don't want to lose 
the horizontal spacing when you retranslate the document back into its 
original operating system. 

Figure 8-10 shows a typical options dialog box for the text translator in the 
"MS-DOS to Mac" menu. 
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Figure 8-10 
The "MS-DOS to Mac" text translation options dialog box 
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To change settings, follow these steps: 

1. Click the appropriate buttons or check box. 

2. Type in numbers where necessary. 

3. Click OK to confirm and close the options dialog box. 

The new settings remain until you change them again or quit Apple File 
Exchange. You can save them for further use by choosing the Save Setting As 
command from the File menu. (See "Saving and Restoring Settings" later in 
this chapter.) 

The DCA-RFf translators 

The AFE folder on your Utilities disk contains one translator file, DCA-
RFT /MacWrite, which contains two translators, "DCA-RFT to MacWrite" and 
"MacWrite to DCA-RFT." You use the former to convert MS-DOS word 
processing files-such as those created with DisplayWrite 3 or DisplayWrite 4-
that have been saved in Document Content Architecture/Revisable Form Text 
(DCA-RFT) format into MacWrite documents. You use the latter to convert 
MacWrite documents to DCA-RFT. 

Most of the information, including format instructions as well as text, is 
passed along in the translation, but some features of DCA-RFT cannot be 
carried over into MacWrite, and vice \'ersa. In some cases the translator 
merely makes a change. In others, it generates a message in the AFE User 
Log, telling of a change. And sometimes it even shows omitted text in the 
User Log. 
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When you use the "DCA-RFf to MacWrite" translator to create a MacWrite 
document, the translated file does not fu lly become a MacWrite document 
until you open it. If you plan to retranslate the document into a DCA-RFf 
file, open and then save the file before carrying out the reverse translation. 

Features omitted 

The following features of DCA-RFf are omitted or ignored when a DCA-RFf 
file is translated into MacWrite: 

o automatic hyphenation 

o backspacing in left margin 

o character realignment within paragraphs 

o different header/footer for even pages 

o footnote formatting 

o line end zone {right sub-margin) 

o line numbering 

o maximum/minimum number of lines per page 

o move/copy column to second column 

o multiple headers and footers per document 

o multiple-line headers/footers 

o overstriking 

o page increment other than one 

o page number reset within documents 

o paragraph keeps 

o printer operator message 

o specified top/bottom margins 

o spell checking 

o stop code 

o suppressed footer-that is, the footer is always shown in the translated 
document 

o text unit insertion 

o text unit number 

o visual attributes such as blinking, reverse video, and no-display 
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Features changed 

The following features of DCA-RFf are changed when a DCA-RFf file is 
translated into MacWrite: 

o Automatic page numbering is shown only at the right edge of the top line 
of the header or footer. 

o Centered or right-justified text is left-justified from a tab stop or the 
margin. Use the ruler or alignment commands from the Format menu to 
restore right-justification or centering. 

o The distance between margins, which has no minimum in DCA-RFT, is 
expanded to MacWrite's minimum two inches. 

o Double underlining is changed to single underlining. 

o Horizontal spacing changes with type size. When converted text goes 
past the next tab stop, a tab skews the text. This is easily solved by 
widening the tab spacing. 

o Outlines are identified by messages telling the level number of each line. 
You can convert any such line by adding as many MacWrite tabs as the 
level number for each line. 

o Special characters-such as backspaces and the null character-are replaced 
by rectangular outlines. 

o Suppressed headers in DCA-RFf cause MacWrite to suppress both the 
header and footer for the page. 

o Tab stops are accepted by MacWrite only up to the first ten. Comma­
aligned tabs are converted to decimal tabs; colon tabs are converted to 
left-justified tabs. 

o Type fonts and sizes are approximated. 

o Vertical line spacing is approximated. 

o Vertical tabs are converted to carriage returns. 

120 Chapter 8: Apple File Exchange: Advanced Features 



MacWrite to DCA-RFI' 
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Some features that are kept when a MacWrite file is translated into DCA-RFT 
may be lost when the DCA-Rff file is subsequently converted into a word 
processor file. For example, the "MacWrite to DCA-RFT" translation retains 
line breaks and page breaks, but that information is not kept when the file is 
converted to DisplayWrite 3 or DisplayWrite 4. To format your document 
correctly, use DisplayWrite's Paginate Document command. The Paginate 
Document command is found in the main (Text Task Selection) menu of 
DisplayWrite 3. In DisplayWrite 4 you can show a menu containing the 
Paginate Document command either by pressing Control-F7 or choosing the 
End/Save command (F2). 

Similarly, the "MacWrite to DCA-RFT" translation retains the format of 
centered and right-justified text, but that text may be left-justified when 
the file is converted to DisplayWrite 3 or DisplayWrite 4. You can easily 
change the justification after translation. 

In addition, the DCA-Rff translation does not limit the size of headers and 
footers, but the conversion to DisplayWrite 3 or DisplayWrite 4 does. 

Features omitted 

The following features of MacWrite are omitted when a MacWrite file is 
translated into DCA-RFT: 

o date and time in header or footer 

o graphics 

o hanging indents 

Features changed 

The following features of MacWrite are changed when a MacWrite file is 
translated into DCA-RFT: 

o Automatic page numbering is shown only at the right edge of the top line 
of the header or footer. 

o Centered text that was centered using MacWrite's ruler is left-justified 
after translation. However, text centered using the Align Center 
command in the Format menu is centered after translation. 

o Horizontal spacing changes with type size. When converted text goes 
past the next tab stop, a tab skews the text. This is easily solved by 
widening the tab spacing. 
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o Italic, outline, and shadow type styles are changed to bold. 

o Paragraph indents are changed to two spaces. To get full indents, use 
tabs. 

o Type fonts and sizes are approximated, except for large sizes, which are 
reduced. 

o Unrecognized characters are represented by the underscore character. 

o Vertical line spacing is approximated. 

Saving and restoring settings 

In this chapter you have learned how to activate and deactivate translators 
in the translation menus, to add other translators to the menus, and to set 
translation options. All such settings remain until you change them or quit 
Apple File Exchange. 

To save yourself time in the future, you can save the current settings simply 
by choosing Save Settings As from the File menu. This saves in one special 
file the settings in all the option dialog boxes and translation menus, 
including check marks and added translators. 

Whenever you are ready to use those settings, choose the Restore Settings 
From command from the File menu. 

When you choose Save Settings As, Apple File Exchange presents a dialog box 
allowing you to name the settings file and to designate the disk and folder 
where it is saved. (See Figure A-2 in tl1e Appendix, "Moving Through the File 
System," for an example.) When you choose Restore Settings From, Apple File 
Exchange presents a dialog box allowing you to select the settings file of 
your choice. 
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Map 

AP JS A MACINTOSH lITIUTY THAT RECORDS AND DISP!AYS THE LONGITUDE 

and latitude of locations anywhere in the world. If you want to phone 

someone in Paris, Tokyo, or any other place, you can use Map to tell what 

time it is there. If you plan to travel to Detroit, Jerusalem, or some other 

destination, you can determine the shortest (great circle) distance to that 

point. And if you're moving your Macintosh from one location to another, 

you can use Map to reset your Alarm Clock desk accessory. 
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With Map, you can set the Current Location, which is stored in your 
Macintosh just like the time and date. You can call upon that location from 
application programs or from HyperCardn.1• 

You can use Map on the Macintosh Plus, Macintosh SE, or Macintosh II, as 
long as you are using a current or recent version of Macintosh system 
software with a modular Control Panel. 

Installing Map 

Map is found on Utilities disk 1. It is identified by the globe icon. 

To use Map for the first time, you install a copy of the Map utility in the 
System Folder on the disk that you plan to use as your startup disk. Follow 
these seeps. 

1. Start up your Macintosh using the startup disk that you want to 
use with Map. 

2. Make sure the System Folder is visible. 

3. Insert Utilities disk 1. 

4. Copy Map into the System Folder by dragging the icon 
representing Map onto the System Folder on your startup disk. 

•!• Note: For more on startup disks, designating the startup device, and 
startup procedures, see your Macintosh System Software User's Guide or 
Chapter 1, "Apple HD SC Setup," in chis manual. 
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Opening Map 

Map appears as a window in rhe Control Panel desk accessory. You can open 
Map while working in the Finder or any application. Follow these steps. 

1. Choose Control Panel from the Apple menu. 

2. If Map is installed, but the Map icon is not visible on the left, 
scroll it into view. 

3. Click the Map icon. 

The Map window, containing a Plate Carree projection, appears (see 
Figure 9-1). 

Flashing points mark recorded locations ----------~ 
(all over map) 

The flash ing star marks the ---------==---'---" 
displayed location (Dallas) 

The flashing cross marks the - - - ---,-i_--j--+-T;;-=;:;;""':-t:=='S 
Current Location (Cupertino) 
Check to signify Nonh latitude --- --'!---- -;--;,----------. 

Check to signify East longitude ----------+----~ 
Check to signify positive time zones - ---r----- -t-o::T"""----... 
(ahead of Greenwich Mean Time) 
Location name box (type or display ----+--.~*---+:1r.ftlrlioi!ir;,;;;,;;;,-
location name here) 
Type or edit degrees and minutes -------- -+-- -=---" 
separately 
Click here to display Time Difference _______ _,_ 

Distance from displayed location to -----+-- - --+-
Current Location ~---~-----------~ 

Current time ------- - ---------- ---" 

Figure 9-1 
The Map window in the Control Panel 

•:• Note: If you want a magnified map image (showing less of the world, 
at larger scale), hold down rhe Option bunon while clicking the Map 
icon. To return to the normal scale map, close and reopen Map. 
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Finding a location by 
its name 
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Finding a location 

The Map utility contains preset coordinates for many of the world's largest 
cities, and in the next section you'll learn how to add even more locations. 
You can find any recorded location by using either of the following two 
methods: 

All recorded locations are identified by a name. If you know the name and 
the correct spelling for a city or other location that you want to find, use 
this method. 

1. Type the name of the location. 

Edit the name, if necessary, in the usual Macintosh fashion. 

If you aren't sure that you spell the location's name the same way Map 
does, just type the first few letters. Map finds the first location in its 
internal list that begins with those letters. 

2. Click the Find button or press Return. 

If Map finds the location, a flashing star appears at its position on the 
map, and d1e location's coordinates and time zone are shown below. 

If Map cannot find the location, your Macintosh sounds a beep. 

•!• Note: If you hold down the Option key while clicking the Find button, 
Map displays, one at a time, the recorded locations. The location names 
appears in the order of Map's internal list. The preset list is 
alphabetized, but any locations you add are listed in the order that you 
add them. 
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Finding a location using 
the map 

All recorded locations are also identified by small flashing points at their 
positions on the map. (If you hold down the mouse button while the map is 
selected, the flashing speeds up.) 

If you don't know the name of a location, but you know generally where it 
is, use this method to find a location. 

1. If the portion of the map that contains the location you are 
seeking is not visible, scroll it into view by clicking near any of 
the map's edges and dragging outside. 

Drag away from the edge to speed scrolling. 

2. Click near the location you are seeking, and drag to it 

As soon as the pointer touches a point marking a recorded location, a 
flashing star replaces the point. The location's name, coordinates, and 
time zone are shown below. 

If the wrong location name appears, try again. There is no guarantee, 
however, that the location you are seeking is prerecorded in Map. 

Finding a location 127 



To add a location 
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Adding, changing, and removing locations 

Unless the Map file is locked, you can alter Map's list of recorded locations by 
adding, changing, or removing individual locations. 

If you want to add a location that is not prerecorded in Map, follow these 
steps: 

1. If the portion of the map that contains the location you're 

-

adding is not visible, scroll it into view by clicking near any of ~ 
the map's edges and dragging outside. 

2. Click at the position of the location. 

A flashing star appears at the position, and its coordinates and 
approximate time zone are displayed below. 

You can use an existing recorded location, but you can't change its 
coordinates without changing its name or removing it first. 

3. Type the name of the location. 

If necessary, first select the location name box. 

You can edit the name in the usual Macintosh fashion. 

4. If the position is not accurate enough, select the latitude or 
longitude, and type new coordinates. 

You can edit both the latitude and longitude in the usual Macintosh 
fashion. Type or edit degrees separately from minutes. Click to check the 
compass check boxes to signify north latitudes and east longitudes; click 
to uncheck the check boxes to signify south latitudes and west 
longitudes. 

The flashing star does not move to the adjusted coordinates until you 
click the Add City button. 
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To change or remove 
a location 

5. If the time zone is not accurate, select Time Zone and type in the 
correct number. 

The Time Zone line shows the hours and minutes a zone is ahead (east oO 
of Greenwich Mean Time if the check box is checked; it shows how much 
a zone is behind (west oO Greenwich Mean Time if the box is not checked. 
You click to check or uncheck the box. (Greenwich Mean Time is the 
world's reference time zone. It is the standard time at the Greenwich 
Observatory, near London, England.) 

Map estimates the time difference based solely on longitude. Since the 
boundaries and time of time zones are detennined politically, you may 
need to consult a time zone chart, map, atlas, or globe for the correct time 
shift. 

6. Click the Add City button. 

The location is now recorded. When you next click at another spot, a 
flashing point appears at the added location. 

Once a location has been recorded (added), you cannot change its 
coordinates or time zone unless you remove it and then add it again. 

If a beep sounds, the location's name is already recorded. 

Follow these steps if you want to correct the coordinates or time zone of a 
recorded location or if you want to to remove it from your map: 

1. Use either method described earlier to find the location. 

2. Click the Remove City button. 

The location is still shown on the screen, but it is no longer recorded. 

3. If you want to keep the location, but change the coordinates or 
time zone, type or edit the new numbers. Then click the Add City 
button. 
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Setting the Current Location 

You set the Current Location so you can use Map to compare distances and 
times between that location and any other point on the globe. (See the 
following section.) Though Map displays a large number of locations, you set 
only one Current Location. 

You'll probably want to set the current location in the city where your 
computer is physically located, but if you want to pretend it's someplace 
else, that's OK too. 

Like the time on your Macintosh clock, the Current Location is stored in your 
computer's battery-powered memory. The most recent setting is retained, 
even if you use another startup disk. 

Application programs, such as travel information programs, and HyperCard 
stacks may call upon the Current Location. 

To set the current location, follow these two simple steps: 

L Find or Add the location you plan to set as your current location. 

2. Click the Set button. 

The displayed location is stored as the Current Location. 

A flashing cross, about the same size as the flashing star, now marks the 
current location. The flashing cross remains at that spot until you reset 
the current location. 

Unless you are setting the Current Location for the first time, Map 
automatically adjusts the current time. For example, if you are changing your 
current location from San Francisco, in the -5 time zone, to New York, in the 
-8 time zone, at 8:00 in the morning (by your Macintosh clock), the time is 
immediately changed to 11:00 A.M. Your Alarm Clock desk accessory is 
changed as well. 

When you close and reopen Map, the Current Location is always displayed. 
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Comparing locations 

Once you've set the current location, you can use Map to determine the time 
anywhere in me world or determine the shortest distance (great circle route) 
becween a selected location and your current location. 

• Select the location you want to compare with the current 
location, using any of the following four methods. 

o Find a recorded location, either by typing ics name and clicking me Find 
buuon or by clicking on a small flashing point 

o Add a new location, typing the accurate coordinates and time zone. 

o Select an unnamed location by typing ics coordinates, as follows: First, 
make the location name blank by selecting an unnamed location. 
Second, type the coordinates. Third, click the Find buuon or press 
Return to move the flashing star to me coordinates you just entered. 

o If the approximate time or distance is adequate, click any position on 
me map, even where there's no recorded location. 

The current time is now me time at me selected location. If the time zone 
entry for the selected location is approximate, then the current time is 
approximate. 

•!• Note: Click the words "Time Zone" to show me difference in time 
becween me current location and the selected location. The words "Time 
Differ." then appear; click them to display the Time Zone again. 

The shortest (great circle) distance-that is, a close approximation- between 
the current location and the selected location is also displayed. 
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Special Installation 

Yu CAN USE THE INSTAllER, FOUND ON U11U17ES msK 1, ro CREA TE A SMALL 

System Folder or to set up your Macintosh as an AppleShare® workstation. 

It works exactly like the Installer found in the Setup Folder on your System 

1bols disk. (The Installer is described in detail in the Macintosh System 

Software User's Guide.) 
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134 Chapter 10: Special Installation 

Creating a small System Folder 

You can use the Installer on Utilities disk 1 to create a scaled-down version 
of the System Folder-less than half the size of the System Folder found 
on your System Tools disk-on a blank, initialized disk. This System Folder 
contains the minimum resources that you need to use your Macintosh. 
Although you can install a small System Folder on a hard disk, the special 
installation resources are designed to make it easier to use a 3.5-inch disk as 
your startup disk. 

The Installer on Utilities disk 1 allows you to select a small System Folder for 
the Macintosh II , Macintosh Plus, or Macintosh SE. (See Figure 10-1.) 

•:• Note: The installation resources are called Minimum Macintosh II, 
Minimum Macintosh Plus, and Minimum Macintosh SE. Do not confuse 
these with the Minimum Macintosh partition scheme described in 
Chapter 1, "Apple HD SC Setup." 

The installer creates a System Folder containing a System file without those 
portions of the System file that are needed only by the other two machines. 
Consequently, you can use your disk as a startup disk only with the kind 
of Macintosh that you've selected. For example, if you select Minimum 
Macintosh Plus, you can't use the startup disk you're creating to start up a 
Macintosh SE or Macintosh II. 

Your small System file includes only a limited number of fonts and desk 
accessories. To add more, use Font/DA Mover, which is found in the 
Font/DA Mover folder on Utilities disk 2 and described in Chapter 4 of this 
guide. The fonts and desk accessories normally found in the Macintosh 
System file are included in the Fonts file and Desk Accessories file in the 
Font/DA Mover folder on Utilities disk 2. 

The small System Folder does not contain all the system software normally 
found in the System Folder on your System Tools disk. To add missing files, 
simply drag them into your System Folder from the System Folder on your 
System Tools disk or any other disk. Then restart your Macintosh. 

•:• Note: To use MultiFinder with your small System Folder, add both the 
MultiFinder file and the DA Handler file to the System Folder. Then 
restart your Macintosh. 

The small System Folder does not contain any printer resources. Drag any 
resources you need from the Printing Tools disk to your small System Folder. 
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Setting up an AppleShare workstation 

If you plan to use your Macintosh as a workstation using the AppleShare file 
server, use the Installer to install the AppleShare workstation software, 
including the Access Privileges desk accessory, on an existing startup disk. 
Select AppleShare in the special installation dialog box. See the AppleShare 
User's Guide for additional instructions. 

Using the Installer 

These instructions assume your system has either two 3.5-inch disk drives 
or a hard disk and at least one 3.5-inch disk drive. Using the Installer on a 
system with a single 3.5-inch drive and no hard disk requires too much disk 
swapping to be practical. 

•:• Note: With a single 3.5-inch disk drive and no hard disk, you may not want 
to install recent versions of the Macintosh system software. To install 
and make practical use of the latest system software, you need at least 
two 3.5-inch drives. 

Follow these steps to install a small System Folder or AppleShare 
workstation software: 

1. Start up your Macintosh using Utilities disk 1 as the startup disk. 

If you have a ~ard disk and only one 3.5-inch disk drive and you're 
planning to install onto a 3.5-inch disk, start up your Macintosh using 
your hard disk as the startup disk. Then copy both the Installer and the 
Special Installer Scripts folder from Utilities disk 1 to the disk-level 
directory on your hard disk. 

2. Select and open or double-click on the Installer icon. 

The special installation dialog box appears. (See Figure 10-1.) 
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Figure 10-1 
The special installation dialog box 

3. If you're planning to use a 3.5-inch disk as your startup disk, 
insert it into the empty 3.5-inch drive. 

• You can only install a small System Folder on a blank, initialized disk. 

• You can only install AppleShare workstation software on a disk that 
already contains a System Folder. 

4. Use the Drive button to select your intended startup disk. 

The name of the disk that's currently selected appears at the upper-right 
corner of the box (above the buttons). If it's not the name of the disk 
you want, click the Drive button until you see the correct disk name. 
(Eject and insert disks as needed.) 

5. Select the appropriate installation resource. 

When you select a resource, there's a delay while the Installer calculates 
how much space will be left on your startup disk after installation. 

6. Click the Install button. 

7. When you see a message reporting that installation has been 
successfully completed, click Quit to exit from the Installer. 

8. Restart your Macintosh using the new or updated startup disk. 
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Reference 153 

CloseViewrM is a Macintosh utility designed to make it easier for 
visually impaired users to read or view screen images. It's so 
simple to use, however, that anyone who wants to take a closer 
look at the screen may find Close View valuable. 
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With Close View installed, you can magnify the contents of your 
screen two to sixteen times. You can also invert the display of 
the entire screen to make images appear white on black instead 
of black on white, and vice versa. 

When you use CloseView, you work with application 
programs, desk accessories, and the Finder the same way you 
would without CloseView. When you print a document or 
make a screen shot, CloseView's magnification and inversion 
features are ignored. 

You can use CloseView on the Macintosh Plus, Macintosh SE, 
or Macintosh II, as long as you are using a current or recent 
version of Macintosh system software with a modular Control 
Panel. 

On the Macintosh II, CloseView works best in black and white. 
In general, the smaller you set the number of colors or grays in 
the Monitors module of your Control Panel, the faster 
Close View performs. (If Close View is installed, you may have to 
scroll the Control Panel icons so you can select the Monitors 
icon. When you reset the number of colors or grays, restart 
your Macintosh to activate the new settings.) 

CloseView was created for Apple Computer, Inc. by Berkeley 
System Design, based upon its inLARGE™ program. 
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INSTALLING CLOSEVIEW 

Close View is found on Macintosh Utilities disk 2. It's identified 
by the magnifying glass icon. 

To use Close View for the first time, you must put a copy of the 
CloseView utility into the System Folder on the disk that you 
plan to use as your startup disk. Follow these five steps: 

1. Start up your Macintosh using the startup disk that you want 
to use with Close View. 

2. Make sure the System Folder is visible. 

Current versions of the System Folder are marked by a 
Macintosh icon on the folder icon, as shown in Figure 11-1. 

3. Insert Utilities disk 1. 

4. Copy Close View into the System Folder by dragging the icon 
representing CloseView onto the System Folder on your 
startup disk. 
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Figure 11-1 Installing Close View 

5. Restart your Macintosh. 

Close View is now installed. A thick rectangular outline, called 
the frame, marks off a small portion of your screen. 
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•!• Note: For more on startup disks, designating the startup 
device, and startup procedures, see your Macintosh System 
Software User's Guide or Chapter 1, "Apple HD SC Setup," in 
this manual. 

FRAMING YOUR VIEW 

The first time you use CloseView, the rectangular frame 
marks off approximately 1/16 of the screen. Except when 
magnification is turned on, the frame is shown whenever 
CloseView is installed. See Figure 11-2. 

The frame works like the rim of a magnifying glass, marking off 
the portion of the screen that will be magnified. To ensure that 
the marked portion includes the area where you are working, 
the frame fallows the movement of the pointer or insertion 
point. 

• To move the frame, use the mouse to move the pointer. 
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Figure 11-2 The frame appears on the screen 

MAGNIFYING THE SCREEN 

You can turn magnification on and off, as well as change the 
power of magnification, by using your keyboard. (See "Using 
the Control Panel," later in this chapter, for an alternate 
method.) 

142 Chapter 11: CloseView 

-

-

-
-
-
-

--

-



--
---

-
-----
...... 

-------

Turning magnification on and off 

Anytime the frame is visible on the screen, you can turn on 
magnification. 

• To turn on magnification, hold down the Option and 
Command keys and press X. Then release the keys. 

The contents of the frame are immediately enlarged and 
fill your screen. 

As you continue your work, the enlarged screen is 
continuously updated. 

Anytime your screen is 1nagnified, you can turn off 
magnification. 

• To turn off magnification, again hold down the Option and 
Command keys and press X. Then release the keys. 

The screen returns to normal size and the frame reappears. 
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Figure 11-3 A Macintosh SE screen magnified by four 

Changing your view 

When magnification is turned on, the screen resembles the view 
through the lens of a magnifying glass held above a page. As 
you type or move the pointer, the lens moves across (or up or 
down) the "page"-that is, the original screen. 
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• To scroll a hidden portion of the original screen into view, 
move the pointer toward the hidden portion. 

Unless you are at the edge of the original screen, a new 
portion of the screen comes into view. 

When you're typing, the view changes as the insertion point 
moves. When text wraps to a new line, the view moves along 
with it; all you have to do is type. (This feature may not work 
properly with all applications.) 

Changing the power of magnification 

You can set the power of magnification anywhere from 2x to 
16x. Whenever you increase the power of magnification, the 
magnified image is enlarged or, if magnification is turned off, the 
frame is reduced by the same proportion. 

• To increase the power of magnification by one, hold down 
the Option and Command keys and press the Up Arrow key 
( 't ). Then release the keys. 

• To decrease the power of magnification by one, hold down 
the Option and Command keys and press the Down Arrow 
key ( .J). Then release the keys. 
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To check the value of the magnification power, use the Control 
Panel. 

INVERTING THE DISPIAY 

You can change the display on your screen so it app~ars white 
on black rather than black on white. To do this, select the White 
on Black button in the Display section of the Close View Control 
Panel. See the fallowing section for details. 

USING THE CONTROL PANEL 

You can use the Control Panel desk accessory to control all of 
Close View's features. Follow these steps. 

1. Choose Control Panel from the Apple menu at the left of your 
menu bar. 

The position of the Control Panel desk accessory in the Apple 
menu depends upon which other desk accessories are 
installed. 
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The Control Panel appears, as shown in Figure 11-4. The 
General icon is selected on the left. 
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Figure 11-4 The Control Panel 

2. Click to select the Close View icon. 

Spe.:iket­
Volume 

If the Close View icon is not visible, scroll until it is by clicking 
the scroll bar's gray area or clicking the down arrow. 

Using the Control Panel 147 



The CloseView Control Panel appears. (See Figure 11-5.) 
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Figure 11-5 The CloseView Control Panel 

The CloseView Control Panel is divided into five functional 
sections: 

Ill On-Off. Select the lower button to turn Close View off. Select 
the top button to turn CloseView on. CloseView is turned on 
automatically whenever you restart your Macintosh. 
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• Magnification. Select the left button to turn magnification 
on. Select the right button to turn magnification off. 

• Power. The current level of magnification is displayed here. 
Possible levels are whole numbers from 2 through 16. 

Click the up or down arrows to increase or decrease 
magnification or, if magnification is off, to reduce or increase 
frame size. 

• Key Equivalents. Select the right button to disable 
CloseView's keyboard commands: Command-Option-X, 
Command-Option-1", and Command-Option-.J. 

When the key equivalents are off, the only way to change 
magnification or turn it on or off is by working in the 
Control Panel. Use this option if you expect to leave 
magnification on at the same power for extended periods, 
and you don't want anyone to change the settings by 
mistake, or if your application program requires the same 
keyboard combinations. 

Select the left button to turn the keyboard commands on 
again. Use this option if you expect to turn magnification off 
and on frequently, or to change the power of magnification 
often. 
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•:• Note: You can't use MacroMaker to assign alternate key 
equivalents for CloseView. 

• Display. Select the lower button to invert the screen to white 
on black, as shown in Figure 11-6. Select the upper button to 
return the display to normal. There is no keyboard equivalent 
for this feature. 

C:alrulator 

Figure 11-6 The screen in Figure 11-3 shown inverted 

Control Panel settings, unlike settings made using the keyboard 
commands described earlier, are retained when you restart your 
Macintosh. 
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TIJRNING CLOSEVIEW OFF AND ON 

When Close View is on, the frame is always visible unless you are 
using Close View to magnify the screen. If you want to work with 
a normal size screen without the frame, you can turn Close View 
off. 

• To turn CloseView off, click the Off button at the top of the 
Close View Control Panel. (See "Using the Control Panel," 
earlier.) 

When you turn Close View on again, the Key Equivalents 
setting remains the same. Use either of the following methods to 
turn Close View on: 

• Click the On button at the top of the Close View Control 
Panel. (See "Using the Control Panel," earlier.) 

Using this method, the Magnification, Power, and Display 
settings remain the same as they were when you turned 
Close View off, whether you set them using the Control 
Panel or your keyboard. 

• Restart your Macintosh. 

Using this method, Magnification, Power, and Display return 
to the last settings you made using the Control Panel. 
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REMOVING CLOSEVIEW 

When Close View is installed, it takes up at least 40K of random­
access memory (RAM). If you're using it with color on a 
Macintosh II, CloseView can take up as much as 330K. If you 
need that space, remove Close View when you aren't using it. 
Follow these steps. 

1. Make sure the System Folder containing Close View is visible. 

2. Open the System Folder by selecting its icon and choosing 
Open from the File menu, or by simply double-clicking the 
System Folder icon. 

3. Drag the CloseView icon out of the System Folder. 

If you plan to reinstall Close View later, you can leave it on 
the disk or in another folder on the disk where you can easily 
find it and drag it back into the System Folder. Later, if you 
reinstall Close View and restart your Macintosh, Close View is 
automatically turned on. The other Close View settings­
Magnification, Power, Display, and Key Equivalents-remain 
the same as when you last set them in the Control Panel. 

152 Chapter 11: CloseView 

-

-
-

-



---
-

-
--
...... 

-
-

-
..... 

-
--

If you want to throw the Close View utility away entirely, 
you can drag it to the Trash-but be sure you have a backup 
copy. 

4. Restart your Macintosh. 

Close View is no longer installed. 

•:• Note: You can leave Close View in your System Folder but 
keep it from being installed by holding down the mouse 
button while starting up your Macintosh. Release the mouse 
button when the "Welcome to Macintosh" message 
disappears. 

REFERENCE 

This section summarizes the commands and icons you need 
to know about to use CloseView. 

The Close View icon. The magnifying glass icon 
represents Close View on Utilities disk 1 and in 
the Control Panel that is presented when 
CloseView is installed. 
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Drag the Close View icon into the System Folder 
on your intended startup disk to begin the 
installation of Close View. -
Once Close View is installed, select the -
Close View icon in the Control Panel to present 
the Close View Control Panel, as shown in 
Figure 11-4. 

Drag the Close View icon out of the System 
Folder to remove the Close View utility. ,... 

The Control Panel desk accessory (in the Apple f!!!O!t 
About the Finder ... 

Alarm Clock 
menu). You can open the Control Panel 

Calculator whether you are working in the Finder or in 
Chooser 

an application program. 

The frame. The frame appears whenever 
Close View is on but magnification is turned off. -
It marks off that portion of the screen that will 
fill the screen when you turn magnification on. 

c:::·.~ '#' H 
··..:::i ·- -· 

Option-Command-X. Press these keys 
simultaneously to turn magnification on or off. 

-
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.-. Control Panel. 
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Option-Command-~. Press these keys 
8l9t 

simultaneously to increase magnification by 
.... one power. The maximum power is 16x . 

llml When magnification is turned off, this command 

- reduces the size of the frame. 
... 

This keyboard command does not work when - Key Equivalents is turned off in the Close View ,... 
Control Panel. ... 

._,. C::· .. CI ·~ + ··.:::a ·- Option-Command-.J. Press these keys 

.-. simultaneously to decrease magnification by 

~ 
one power. The minimum power is 2x. 

- When magnification is turned off, this command 
,... increases the size of the frame. 
ll9t 

This keyboard command does not work when 
4llml 

Key Equivalents is turned off in the Close View - Control Panel. 
~ 

P-111'1 

,.. 
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Clean Up Selection 
Empty Trash 

Set Startup ... 

Clean Up Selection 
Empty Trash 

Set Startup ... 

Restart 
Shut Down 

The Restart command (in the Finder's Special 
menu). The Restart command ejects all 3.5-inch 
disks, shuts down your Macintosh, and 
immediately restarts it. 

To complete the installation of Close View on a 
hard disk that you've designated your startup 
device, Choose Restart from the Special menu. 

You also use Restart or the Shut Down 
command to complete the removal of 
CloseView from the System Folder on your 
current startup disk. 

The Shut Down command (in the Finder's 
Special menu). The Shut Down command ejects 
all 3.5-inch disks, shuts down your Macintosh, 
and darkens the screen, with the exception of a 
Restart button and a brief message. 

To complete the installation of Close View on a 
3.5-inch disk, choose Shut Down from the 
Special menu, reinsert the disk containing the 
System Folder with the CloseView utility, and 
click Restart. 
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You also use Shut Down (or the Restart 
command) to complete the removal of 
CloseView from the System Folder on your 
current startup disk. 

.. - .. The System Folder. The System Folder is 
identified, in current versions of the Finder, by 

S 1~ stem F 0 lder a Macintosh icon within a folder icon. 

You copy the CloseView utility into the System 
Folder on your intended startup disk to begin 
the installation of CloseView. 

Reference 157 



A p p E N D 

158 

x 

Moving Through the File System 

YuR MACI•TOSH USES TIIE HIERARCHICAL FILE SYSTEM, WHICH ALLOWS 

you to organize your files-ihat is, system files, application programs, 

and documenrs~n your disks by placing them in folders. It is called a 

hierarchical file system because you can place, or nest, folders within 

folders. 

-

-
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-
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Disk 

System Folder 

System files 

Folders 

Applications 

Documents 

As illustrated in Figure A-1, each disk represents the top level of a hierarchy 
containing all the ftles and folders on that disk. The hierarchical file system, 
including the material in this appendix, is discussed in greater detail in your 
Macintosh System Software User's Guide. 

Figure A-1 
A sample hierarchical file structure 

While working in the Finder, you can actually view each folder and its 
contents by opening, closing, and moving the windows that represent 
folders and disks. And you can move or copy files from folder to folder 
simply by dragging them. 

If you're using an application program or desk accessory, however, you use 
the hierarchical file system by working with directory dialog boxes such as 
those shown in Figure A-2. Each program presents its own variations of the 
dialog box, but you use them all the same way, whether you're opening a file, 
saving a document, or specifying a folder. In fact, once you've used your 
Macintosh for a while, you probably won't even notice the minor 
differences. 
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Current disk ------------+================~..;;..=""'---==='-1 

Directory title-----------1-----

jm11 ,.. . mm-..~ Hill d Or ~ k 

Directory or directory list - - - - - - -H 

I
t . Fell. letters 

Jdn . l Pt ll'I \ 
Janr lette1 
Mill. l elll'I\ 
Morwy Stuff 

W 
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Ll Reminder\ 
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Scroll bar - ---- - -------j:::::::::;:::::::::;;;:::::::;__;;__;;_==-;:::::;:;;,=,,..........=======-d 

Current disk ------------+F====================~======;i 

Directory title ----------,.___ri========:::;::::! 
Meqad1\I< 

Directory or directory list --------tt-i 
Or rue 

Scroll bar -----------il~======.._,, Sat•e settings as: 

I Cancel 

Figure A-2 
Two typical directory dialog boxes 

Notice rhat all directory dialog boxes contain at minimum rhe following 
features: 

• Current disk. This is the name of the disk that the rest of the dialog box 
governs. The icon identifies it as either a hard disk or a 3.5-inch disk. 

• Eject button. If the current disk is a 3.5-inch disk, you can click this 
button to eject that disk. 

• Drive button. Use rhis button to switch disk drives. Each time you click 
Drive another 3.5-inch disk (if one is inserted) or hard disk (if one is 
connected) becomes the current disk. 
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• Directory title. This represents either the current disk or a folder on the 
current disk. 

• Directory or directory list. This shows, in alphabetical and numerical order, 
some or all of the files and folders stored directly in the folder or disk 
named above. However, it does not show items nested in folders that are 
shown in the directory. 

• Scroll bar. If the directory contains more items that fit in the directoy list, 
the scroll bar is grayed. Scroll to show the other items. 

• Cancel button. Use this button to close the dialog box without opening, 
saving, or otherwise specifying a file. 

Moving down the hierarchy 

To move down the file hierarchy-that is, away from the disk level-you 
open folders until the item you want is displayed in the directory or specified 
as the directory name. 

• To open a folder that is listed in the directory, double-click its 
name. 

If there is an Open button or an Open Folder button, you can also click to 
select the name of the folder and then click that button. 

The name of the selected folder becomes the directory title, and its 
contents are listed in the directory. Use the same method to open any 
folder in the new directory. 

Moving up the hierarchy 

You can also move up the hierarchy-that is, toward the disk level-by 
working in the directory dialog box. Follow these steps . 

1. Use the mouse to position the pointer on the directory title, and 
press the mouse button down. 

As shown in Figure A-3, the chain of folders leading to the disk directory 
is shown under the name of the current disk. It's similar to pulling down 
a menu. 
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2. Drag the pointer down to the folder (or disk) that you want to 
specify as the directory name. 

The folder (or disk) that is highlighted when you release the mouse 
button becomes the new directory title. Folders directly nested within 
that folder (or disk) are now displayed in the directory list. 

• I ·= Hard 01sk 
0 late 1 esi Corresponde nce 

0 late 1 = Hard Di sk 

D late Shou• 
D Misc. Bills 
D Subsc rip lions 

Open 

Cancel 

Figure A·3 
Moving toward the disk directory 

•:• Note: Whenever you use the Eject or Drive button to switch disks, you 

----
-

-
--
-

automatically move to the top of the file hierarchy for the new disk. That ~ 

is, the disk is shown as the directory name. 

Moving across the hierarchy 

If you're working in a folder and want to move to a folder in another branch 
of your file structure, just move up the hierarchy to a directory in which 

--
both folders are nested. Then move back down again. -

-
..... 
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Glossary 

Apple menu: The farthest-left menu in the menu bar, 
indicated by an Apple symbol, from which you choose desk 
accessories. 

application or application program: A program written for 
some specific purpose, such as word processing, database 
management, graphics, or telecommunication. 

back up: (v.) To make a spare copy of a disk or of a file. 
backup: (n.) A copy of a disk or file. 

background: A program operates "in the background" if it 
continues to function, automatically, while you use another 
program. 

binary: The representation of numbers and other characters 
in the base-2 system, using only the rwo digits 0 and 1. 

choose: To pick a command by dragging through a menu. 
You often choose a command after you've selected 
something for the program to act on. See also select. 

control character: On ProDOS and MS-DOS computers, a 
nonprinting character that controls or modifies the way 
information is printed or displayed. Control characters are 
typed by holding down the Control key while pressing some 
other key. In the Macintosh family, the Command key 
performs a similar function. 

current startup disk: The disk that contains the system files 
the computer is currently using. The startup disk icon is 
usually in the upper-right corner of the desktop. 

desk accessories: "Mini-applications" that are available from 
the Apple menu regardless of which application you're using. 

destination: (adj.) Describes the disk or folder that receives a 
copied or translated file, as in destination disk. 

directory: A pictorial, alphabetical, or chronological list of the 
contents of a folder or a disk. 

driver: A program that lets a peripheral device and a 
computer send and receive information. Printer drivers 
control printers; a hard disk driver controls exchanges 
between a hard disk and a computer. 

eligible: (adj.) In Apple File Exchange, a file is eligible if it can 
be translated with a selected translator or translators. 

filename: The name that identifies a me. The maximum 
character length of a Macintosh filename is 31 characters for a 
document or folder, 27 characters for a disk. A name can't 
comain a colon (:), and it should not begin with a period (.). 

font: A complete set of characters in one design, size, and 
style. 

frame: In CloseView, the frame is a thick rectangular outline 
that marks off the portion of the screen that will fill the screen 
when you turn on magnification. 

free space: The portion of a disk that is not contained in a 
partition. 

global backup: The process of backing up all the files on a 
hard disk. 

hierarchical file system (HFS): A form of computer 
memory organization in which mes, including folders, can be 
nested within folders. 

icon: An image that graphically represents an object, a 
concept, or a message. For example, Disk First Aid is 
represented by an ambulance; CloseView is represented by a 
magnifying glass. 
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inaemental backup: The process of backing up all fdes on a 
hard disk that have been created, modified, or copied onto 
the disk since the last global backup. 

initialize: To prepare a blank disk to receive information by 
organizing its surface into tracks and sectors. 

invert: To change a portion or all of your Macintosh screen 
so it appears as white on black instead of as black on white. 

keystroke: A key or key combination that you assign to a 
macro. When pressed, it triggers the playing of the macro's 
script. 

macro: A recorded sequence of characters and commands, 
identified by a name and possibly triggered by a keystroke. 
Using MacroMaker, you can call upon a macro to play while 
you're working in an application. See also script. 

modifier key: A key that you press in combination with a 
readable character to change its meaning. Sometimes you 
press a modifier key to change the action of clicking or 
dragging. Examples of modifier keys are Command and 
Option. 

MS-DOS: The Microsoft Disk Operating System. It's the 
operating system that governs the IBM PC (under the name 
PC-DOS) and compatible computers. 

operating system: A program that organizes the actions of 
the parts of the computer and its peripheral devices. 

partition: (n.) A portion of a memory device-such as a 
hard disk or tape-that is treated like a device itself. For 
example, if you select the 50% Macintosh partition scheme 
provided by Apple HD SC Setup, your Macintosh volume, 
shown as a hard disk in the Finder, will take up about half 
your hard disk. (v.) To create partitions. 

power: In CloseView, the level of magnification. For example, 
with the power set at 4x, screen images appear four times as 
large when magnified. 

ProDOS: The Professional Disk Operating System. It's the 
operating system that today controls most Apple II-family 
computers. 
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random-access memory (RAM): The part of a computer's 
memory that stores programs and other information 
temporarily while you're working with it. 

scratch: Disk space not normally available in the Macintosh 
operating system, but requested by some programs­
Macintosh and non-Macintosh-for use as temporary storage. 

screen shot: A MacPaint document that is like a snapshot of 
your Macintosh screen. You make a screen shot by holding 
down the Command and Shift keys while pressing 3. 

script: In MacroMaker, a recorded sequence of characters 
and commands, part of a macro. 

SCSI: See Small Computer System Interface. 

SCSI ID number: A number assigned to each SCSI device 
connected to a computer. The device with the highest 
number has priority if a conflict occurs while sending or 
receiving data. Some devices, such as internal hard disks, have 
preset SCSI ID numbers. On others, such as external hard 
disks, you use a SCSI ID switch to set the ID number. 

select: To designate where the next action will take place. To 
select, you click an icon or drag across information. 

Small Computer System Interface (SCSI): A specification 
of mechanical, electrical, and functional standards for 
connecting intelligent peripherals such as hard disks, printers, 
and optical disks to small computers. 

source: (adj.) Describes fdes that are being copied or 
translated as well as the disk or folder containing source files. 

startup disk: A disk with all the necessary program 
fdes-such as the Finder and System file contained in the 
Macintosh System Folder-to set the computer into 
operation. 

System file: A file Macintosh computers use to start up and to 
provide system-wide information. 

System Folder: A folder containing the System file plus other 
important programs for controlling the Macintosh and its 
peripheral devices. 

-

-

-

-

-



-

-

-
-
-
-

text file: A fde that contains information stored in the form of 
readable characters. On the Macintosh, they are known as Text 
Only documents. On the Apple II, they are called TXT ftles. 

translation menu: A menu, such as "Mac to MS-DOS" or 
"Mac to Mac," that appears when two disks are shown in the 
Apple File Exchange window. 

translator: The information that the Apple file exchange 
utility needs to translate a document created with an 
application on one operating system into a document that 
can be used with a similar application on another operating 
system. 

translator file: A file containing one or more Apple File 
Exchange translators. 

volume: A general term referring to a storage device; a source 
of or a destination for information. 
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Index 

A 
About Apple File Exchange window 

104-105 
Access Privileges 135 
activating translators 95-96, 102 
adding 

desk accessories 45-49 
locations (Map) 128-129 
macros 77, 80 
partitions 14-19 

AFE. See Apple File Exchange 
Alarm Clock, resetting. See Map 
Another File command (MacroMaker) 

79 
Apple File Exchange (AFE) 83-100, 

101-122. See also translator files; 
translators or specific translator 
file/translator 

advanced features of 101-122 
basic features of 85-99 
400K disks and 92 
opening 89 
quitting 99 
requirements 86 
translators and 103-104 
User Log 114-115 
uses for 85-88 
using 88-99 

Apple File Exchange folder 86--87 
Apple Hard Disk SC. See Hard Disk SC 
Apple HD SC Setup 1-22 

MultiFinder and 2 
partitions and 2, 12-22 
testing hard disks with 11 
versions of 2, 4 

Apple menu 44. See also desk 
accessories 

Apple PC 5.25-inch disk drive 85, 86. See 
also Apple File Exchange 

AppleShare, setting up 135-136 
Apple Tape Backup 40SC. 
Apple IIGS 85. See also Apple File 

Exchange 
applications 91 , 159. See also files; Find 

File 
opening files from with Find File 

60--01 
application-specific macros 66, 70. See 

also macros 
automatic repair (Disk First Aid) 40 
A/UX, partitioning for 12- 14 
available macros 73. See also macros 

B 
background, operating in (with Find 

File) 58 
backing up 24-31 

files 25-31 
globally 24, 26-28 
hard disks 24-25 
incrementally 24, 29-30 
System Folder 10 

"Back up all files" function 26-28 
"Back up a single file" function 30-31 
"Back up changed files" function 29-31 
binary, defined 87 

c 
calling macros 74 
Caps Lock key, symbol for 68 
carriage return (Apple File Exchange) 

116 

changing 
locations (Map) 129 
macros 75-76 
macros files 74-78 
partition size 16-17, 20 
power of magnification (CloseView) 

145 
views (CloseView) 144-145 

checking 
macros 75 
macros files 74-78 

CloseView 137-157 
Conttol Panel and 146-150 
installing 139-141 
Macintosh II and 138 
random-access memory and 152 
reference 153-157 
removing 152- 153 
requirements 138 
turning on/off 151 

colors, CloseView and 138 
Command key, symbol for 68 
commands. See MacroMaker or specific 

command 
comparing locations (Map) 131 
conflicting filenames (Apple File 

Exchange) 111-113 
control characters (Apple File 

Exchange) 117 
Control key, symbol for 68 
Control Panel 8 

CloseView and 146-150 
Map window in 125 

coordinates (Map) 126 
copying 

desk accessories 45-49 
files 30-31 
fonts 45-49 
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macros 77, 80 
macros files 80 

Current Location 125. See also locations; 
Map 

setting 130 
current ti.me 125. See also Map 
custom partitions 14-22 

D 
DA liandler, small System Folder and 

134 
damaged drivers, replacing 10 
Dataviz, Inc. 87 
Date Created/Modified, HD Backup and 

29 
DCA-RFT/MacWrite translator file 86, 95, 

118-122 
"DCA-RFI' to MacWrite" translator 95, 

119-120 
"Default translation" 87 
desk accessories 44-49 

Access Privileges 135 
copying 45-49 
mes 44 
Find File 51-62 
removing 45-49 

desktop, moving files to 59--00 
destination disk 90 
destination files 92-93 
destination folders 92-93 
Details window (in Apple HD SC Setup) 

21- 22 
directories. See hierarchical file system 
directory dialog box 160-161 
directory/directory list 160, 161 
directory title 160, 161 
Disk First Aid 37-42 

automatic repair and 40 
preparing disk for 38 
when to use 38-39 

disks 159. See also Disk First Aid; Find 
File; hard disks 

current 160 
current startup 44 
destination 90 
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examining 42 
locked (Apple File Exchange) 91 
repairing 42 
source 90 
startup 6--8 
tescing 11 

display, inverting (Close View) 150 
DisplayWrice 121 
Document Content Architecture/ 

Revisable Format Text. See DCA­
RFT/MacWrite translator file 

documents 91, 159. See also files; Find 
File 

Drive button 160 
Driver (partitions) 18 
drivers 5 

E 

damaged 10 
replacing 10 
updating 9 

SOOK disks 25. See also disks 
examining or repairing 42 

Eject button 160 
eligible files 105 

disks 42 
hard disks 40-42 

F 
50% Macintosh partition 13-14 
filenames 

conflicting (Apple File Exchange) 
111-113 

periods in 25 
files. See also Apple File Exchange; 

applications; documents; Find File 
or specific file 

backing up 25-31 
copying 30-31 
desk accessory 44 
destination 92-93 
eligible 105 
font 44 
macros 66-72, 74-80 

opening (with Find File) 59--01 
restoring 32-36 
searching for 53-56 
source 93-95, 105-107 
text 87 

file server (AppleShare) 135- 136 
Finder, opening files from with Find File 

59-60 
Find File 51-62 

fearures 53 
getting information with 57 
installing 52 
menu 53 
Move to Desktop command 59 
Search Here command 54 
quitting 62 

finding locations (Map) 126-127 
5.25-inch disk icon 94 
folders 91, 159-162. See also Find File or 

specific folder 
destination 92-93 
HD Backup and 33 

Font/DA Mover 43-49 
MultiFinder and 45 

fonts 44-49 
copying/moving 45-49 
files 44 

400K disks 92 
frame (CloseView). 

defined 140, 154 
using 141-142 

free space, defined 15 

G 
global backup 24, 26-28 
global macros 66. See also macros 

creating 70-71 
great circle (shortest) distance. See 

locations; Map 
Greenwich Mean Time 129 
grouping partitions 16, 20 

H 
"Halt" button 53, 56 
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~ hard disk. See also Apple HD SC Setup; K checking 75 
Disk First Aid; disks; Find File; Hard keyboard, remapping. See MacroMaker copying - Disk SC; HD Back.'Up Key Equivalents (CloseView Control to another file 80 

backing up 24-25 Panel) 149 withinafile n - examining 40-42 keystroke, defined 63. See also defmed 63 
1D of 3 MacroMaker ftles - initializing 4-5 changing 74-78 
internal 8 

L checking 74-78 - repairing 40-42 copying 80 latitude. See locations; Map startup 6-8 
line feed (Apple File Exchange) 116 creating 79-80 

""""" testing 11 moving 80 loaded macro. See macros Hard Disk SC, initializing 4-5. See also 
location name box 125 opening 79-80 - hard disk renaming 80 

Help file (MacroMaker) 65 locations (Map). See also Map 
setting up 66-72 - HD Backup 23-36 adding 128-129 
working with other 78-80 

HD Backup dialog box 26 changing 129 
global 70-71 - HD SC Setup 1-22. See also Apple HD comparing 131 
interrupting 74 

SC Setup fmding 126-127 
moving n, 80 

"""" hierarchical file system 51-52, 158-162. removing 129 
recording 66-69 

See also files; Find File locked disks (Apple File Exchange) 91 
removing 78 - moving across 162 locking partitions 21 
reviewing list of 75 

moving down 161 longitude. See locations; Map 
special 71-72 ...... 

161-162 using 72-74 moving up 

...... M "Mac to Mac" text translation 108-110 
Macintosh SE-Bus PC Drive Card 86. See "Mac to MS-DOS" translation 95 l,J 

also Apple File Exchange "MacWrite to DCA-RFf" translator 95, - ID number (SCSI) 3 
Macintosh II PC Drive Card 86. See also 121-122 inactive translators. See activating 

Apple File Exchange magnification, power of (CloseView) ~ translators 
Macintosh volume 13, 26 142-145 incremental backup 24, 29-30 
MacroMaker 63-81. See also macros Magnification (CloseView Control Panel) - init:alizing Hard Disk SC 4-5 

commands 148 Installer 133-136 
Another file 79 magnified map image 125 - installing 
Start Recording 67 Map 123-131. See also locations AppleShare workstation software 
Stop Recording 67 installing 124 F""' 135-136 

Help ftle 65 opening 125 CloseView 139-141 
installing 65 Maximum Macintosh - Find File 52 

MacroMaker 65 menu 73 partition 13 

Map 124 removing 65 Minimum Macintosh ...... 
requirements for 64 partition 13 small System Folder 134-136 
turning on/off 81 small System Folder 134 - internal hard disk 8 
uses for 64 modifier keys, symbols for 68 interrupting macros 74 
window 67 Move to Desktop command (Find File) - inverting display 150 

macros. See also MacroMaker 59 - calling 74 moving 
changing 75-76 desk accessories 45-49 

~ 
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files to desktop 59-60 
fonts 45-49 
macros 77, 80 
macros ftles 80 
partitions 20 
through hierarchical file system 

158-162 
MS-DOS 83 

translating files between ProDOS and 
87, 93, 111 

"MS-DOS to Mac" text translation 95-96, 
117 

"MS-DOS to ProDOS" translation 91, 
lll 

MultiFinder 

N 

Apple HD SC Setup and 2 
Font/DA Mover and 45 
small System Folder and 134 

numeric keypad, symbol for 68 

0 
opening 

Apple File Exchange 89 
files (with Find File) 59--61 
macros files 79-SO 
Map 125 

operating systems, defined 12, 84. See 
also partitions or specific operating 
system 

Option key, symbol for 68 
options, setting (Apple File Exchange) 

116-118 
"Other translations" 95, 108 

p 

partitions 2, 12-22 
adding 14-19 
adjusting size of 16-17, 20 
creating 12-22 
custom 14-22 
grouping 16, 20 
locking 21 
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moving 20 
removing 15, 19 
standard 12-14 
types of 12-14, 17-18 
unlocking 21 
viewing 21-22 

periods, in filenames 25 
playing a script 74. See also MacroMaker 
Power (CloseView Control Panel) 149 
power interruption, problems with disks 

after. See Disk First Aid 
power of magnification (CloseView) 

142-145. SeealsoCloseView 
changing 145 
turning on/off 143-144 

printer resources, small System Folder 
and 134 

ProDOS 83 
translating files between MS-DOS and 

87, 91, 111 
"ProDOS to MS-DOS" translation 91, 

111 
progress window (Apple File Exchange) 

98 

Q 
quitting 

R 

Apple File Exchange 99 
Find File 62 

random-access memory (RAM), 
CloseView and 152 

recorded locations (Map) 126 
recording macros 66-69 
redesignating startup device 8 
remapping the keyboard. See 

MacroMaker 
removing 

CloseView 152-153 
locations (Map) 129 
MacroMaker 65 
macros 78 
partitions 15, 19 

translators 109 
Rename window (Apple File Exchange) 

112, 113 
renaming macros files 80 
repairing 

disks 42 
hard disks 40-42 

replacing damaged drivers 10 
"Restore all files" function 35 

failure of 36 
"Restore a single file" function 33-34 
restoring 

files 32-36 
settings (Apple File Exchange) 122 

reviewing list of macros 75 

s 
saving settings (Apple File Exchange) 

122 
scanning order 7 
Scratch (partition) 18 
screen. See display 
screen shot 164 

with CloseView 138 
script, defined 63. See also MacroMaker 
scroll bars 147, 160, 161 
SCSI device, defined 1 
SCSI Hard Disk. See Hard Disk SC; hard 

disk 
SCSI ID number 3 
"Search for" box 53 
Search Here command (Find File 

menu) 54 
searching for files 53-56 
search region 53 
selecting 

source files 93-95, 105-107 
translators 102-105 

settings, restoring/saving (Apple File 
Exchange) 122 

setting up 
AppleShare 135 
macros files 66-72 
System Folder 6-7 

Shift key, symbol for 68 
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shortest (great circle) distance. See 
locations; Map 

size (of type). See fonts 
Small Computer System Interface. See 

SCSI 
small System Folder, creating 134 
source disk 90 
source files, selecting 93-95, 105-107 
speaker volume, Find File and 56 
special characters (Apple File Exchange) 

116 
special installation (Installer) 133-136 
Special Installer Scripts folder 135 
split files (HD Backup) 32, 34, 36 
standard partitions 12-14 
Start Recording command 

(MacroMaker) 67 
startup device, redesignating 8 
startup disks 

creating 6-8 
current 44 

startup hard disk, creating 6-8 
startup scanning order 7 
Stop Recording command 

(MacroMaker) 67 
subdirectories 92. See also hierarchical 

me system 
symbols, for modifier keys 68 
System ftle 91, 159. See also files; Find 

File 
System Folder 157, 159 

backing up 10 
setting up 6-7 
small, creating 134-136 

T 
tab characters (Apple File Exchange) 

117 
Tape Backup 40SC. See partitions 

~ tape icon (MacroMaker) 65 
text ftles, defmed 87 

- "Text translation" (Apple File Exchange) 
87, 103 

~ 3.5-inch disks. See disks 
time, current (Map) 125 

translator ftles 86. See also Apple File 
Exchange; translators 

DCA-RFT/MacWrite 86, 95, 118-122 
obtaining 87 

translators 86. See also Apple File 
Exchange; translator ftles 

activating 95-96, 102 
Apple File Exchange and 103-104 
"DCA-RFT to MacWrite" 95, 119-120 
list of 104-105 
"MacWrite to DCA-RFT" 95, 121-122 
"Othertranslations" 95, 108 
removing 109 
selecting 102-105 
"Text translation" 87, 103 

type size. See fonts 

u 
UNIX 12-14 
unlocking partitions 21 
updating drivers 9 
User Log (Apple File Exchange) 114-115 

v 
versions (of Apple HD SC Setup) 2, 4 
viewing partitions 21-22 
views (Close View). See also Close View 

changing 144-145 
framing 141-142 

volume, defmed 13, 26 
volume (speaker), Find File and 56 

W, X, Y, Z 
"Walk" button 53, 56 
workstacion (AppleShare) 135 
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THE APPLE PUBLISHING SYSTEM 

This Apple® manual was wrinen, edited, 
composed on a desktOJl publishing system 
using ApJ>le Macintosh® computers and 
Microsoft® Word. Proof eages were created 
on the Apple LaserWriter® Plus; final pages 
were printed on a Varityper® VT600™. Line 
art was created using Adobe Ulustrator1"' and 
typeset on a Llnotronic® 300. The chapter 
openings were drawn using a combination 
of Illustrator and traditional drawing 
techniques. POSTSCRIPT®, the LaserWrlter 
page-description language, was developed 
by Adobe Systems Incorporated. 

Text type and display type are Apple's 
corporate font, a condensed version of 
Garamond. Bullets are ITC Zapf 
Dingbats®. Some elements, such as 
program listings, are set in Apple Courier, 
a fixed-width font. 
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